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Foundation Advantage 

Simulation (Mechanism Dynamics, Design Animation) 

Title  

Custom Loads

Summary  

Mechanism Dynamics has been enhanced to allow users to incorporate custom written and 
compiled dynamic link libraries as input forces to a mechanism for dynamic analysis

Benefits and Description  (200words) 

There is a new method for specifying the values for a force motor or an external force, 
called custom loads.  A custom load is an external program developed by Pro/Toolkit, 
which will be used to compute load values for force motors and external loads.   

When defining the value for the force motor or an external force, users will be able to select 
the customer load program that will evaluate the custom load at each time step of the 
analysis.  In addition, at each time step the user can ask the Mechanism Dynamics engine 
to integrate a set of StateVariables in order to simulate a control system. 

This enhancement enables users to have better control on real-world situation, taking into 
account specific force loads unique to the defined process. 

User Interface Location  

Mechanism / Force Motors / New / Magnitude – Custom Load
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Foundation Advantage 

Fundamentals (Fundamentals, Design Conferencing) 

Title  

Copy and Paste Commands for Features 

Summary  

The Windows style of Copy and Paste commands and key combinations now 
manipulate features.

Benefits and Description  (200words) 

You can copy and paste features to other parts of the model quickly and easily. You can 
use the familiar Copy (CTRL+C) and Paste (CTRL+V) commands and key 
combinations in Windows applications. During the Paste operation, you can interact 
with the feature using the new dashboard and see an immediate preview of the 
features being copied. You copy both features and geometry with the same tool through 
a single unified workflow. 

User Interface Location  

Edit / Copy (CTRL+C) and Edit / Paste (CTRL+V)
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Foundation Advantage 

Simulation (Mechanism Dynamics, Design Animation) 

Title  

Computed Measures

Summary  

Mechanism Design and Mechanism Dynamics now support the ability to create and 
define computed measures with generalized expressions. 

Benefits and Description  (200words) 

You can define measures with generalized expressions of one or more Pro/ENGINEER 
parameters or other measures as variables. With generalized expressions, you can 
convert result data from Mechanism Design and Mechanism Dynamics into a format 
for graph comparison or for use in assigning design-study goals and conditions. 
MECHANICA Motion has the equivalent capability.

User Interface Location  

Generate Measure Results / Create a New Measure / Type – User Defined
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Foundation Advantage 

Assembly and Weld (Pro/PROCESS for Assembly) 

Title  

Assembly Component Interfaces 

Summary  

When editing a component’s placement, you can select predefined component 
interfaces. After using the new Search Tool to find and locate the component, specify 
the rule-based, interface placement options. 

Benefits and Description  (200words) 

You can use an existing set of component interfaces while editing the placement of 
components, or you can create your own component interfaces. You can efficiently edit 
a component’s placement and place it in a new location. The Search Tool finds Interface 
Placement options based on features, geometry types, names, and parameters. This 
tool vastly increases the usability and power of component interface definitions during 
drag-and-drop component placement.

User Interface Location  

Edit / Setup / Comp Interface
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Foundation Advantage 

Part Modeling (Part and Sketcher) 

<Streamline And Expand Offset Curve Creation> 

Summary  

A streamlined workflow for creating offset curves is available. The 
Offset tool operates like the tools for other similar features. ` 

Benefits and Description  

You can quickly create offset curves with the Offset tool. After you 
select a curve and enter the tool, the surface that the curve lies on is 
automatically selected. This provides an immediate preview of the 
offset curve. You can use the dashboard attributes of the feature to 
create the exact curve. 

User Interface Location  

Edit / Offset
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Foundation Advantage 

Model Analysis (BMX, ModelCHECK, Pro/PROGRAM) 

Title  

Check for Standard Model Notes

Summary  

ModelCHECK now analyzes and verifies that all standard model notes exist in the 
model and reports the number of missing notes. This report meets the growing demand 
for drawingless modeling. 

Benefits and Description  (200words) 

With the move toward drawingless modeling, ModelCHECK helps you search for notes 
added to part or assembly models and verify if these notes are per standard. You add 
the standard notes in the ModelCHECK start configuration file. When you run this 
check on the model, ModelCHECK reports on whether the notes exist in the model. 
This check works for part, assembly component, subassembly, and top-assembly notes. 

User Interface Location  

Analysis / ModelCHECK / MC 
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Foundation Advantage 

Surfacing (ISDX, Restyle, Warp, Facet Modeling) 

Title  

Boundary Blend User Interface 

Summary  

The Boundary Blend tool has a more intuitive user interface similar to other features 
in Pro/ENGINEER.

Benefits and Description  (200words) 

The new Boundary Blend user interface provides the most commonly used functions, 
such as boundary conditions, directly in the graphics window and provides enhanced 
visual feedback. 

User Interface Location  

You can see enhancements to the Boundary Blend user interface both dynamically in 
the graphics as well as in the dashboard organization.
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Foundation Advantage 

Surfacing (ISDX, Restyle, Warp, Facet Modeling) 

Title  

Bend Damping 

Summary  

The concept of damping has been added to the Bend tool and in the new Sculpt and 
Spine types of Warp.

Benefits and Description  (200words) 

By damping a bend, the effect of the bend is allowed to “decay” or reduce on the 
geometry further away from the bend axis. This damping allows for finer control of a 
localized region of influence for the bend.

User Interface Location  

An additional size arrow on the Bend marquee is perpendicular to both the bend axis 
and the pivotal direction. You can drag either the base or tip of the arrow to adjust how 
far the bend dampening extends in the selected direction. 
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Foundation Advantage 

Fundamentals (Fundamentals, Design Conferencing) 

Title  

Automatic Annotation Element Parameters 

Summary  

As you create Annotation Elements, you can automatically assign a group of 
parameters to them using a user-defined, custom parameter file.  

Benefits and Description  (200words) 

Custom parameter files provide values for a group of parameters that are to be applied 
to Annotation Elements upon creation. These values ensure that the proper 
parameters are applied to all Annotation Elements. 

To make the parameters automatic for Annotation Elements, you must create a 
specially formatted XML file. This file defines the name, type, and default value of 
parameters. These parameters are to be added to all Annotation Elements by default 
during their creation. Specify the path to this file using a configuration option. 

User Interface Location  

A custom parameter file (XML) is accessed via a configuration option. 
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Foundation Advantage 

Data Exchange (ATB, DataDoctor, Interfaces) 

Title  

Support for AutoCAD 2002 on Export and Import

Summary  

You can export and import file version 2000 of AutoCAD DWG and DXF files. For the 
first time, export and import to Linux and 64-bit platforms is provided.

Benefits and Description  (200words) 

Expanded support for AutoCAD includes the export and import AutoCAD DWG and 
DXF files from AutoCAD 2002 (file version 2000). You can export and import AutoCAD 
data in DXF and DWG formats from the following file versions: 

• 2000 (default in Pro/E Wildfire 2.0) 
• R14 
• R13 

• R12 

User Interface Location  

File / Save A Copy or File / Open
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Foundation Advantage 

Data Exchange (ATB, DataDoctor, Interfaces) 

Title  

AutobuildZ Integration with Pro/ENGINEER

Summary  

AutobuildZ, the free plug-in application for moving to 3D, is integrated into the base 
Pro/ENGINEER package.

Benefits and Description

AutobuildZ allows you to build 3D parametric, feature-based solid models from 2D 
drawing data. Feature creation wizards guide you through the selection of entities and 
references directly in the 2D drawing to create 3D Pro/ENGINEER features. The 
following features are supported: 

• Extrusions (Protrusions and Cuts) 
• Revolves (Protrusions and Cuts) 

• Simple Holes 
• Datum Curves 
• Datum Points  
• Datum Planes 

The unique sketch validation and fixing tools in AutobuildZ automatically confirm the 
entities selected for the sketch profile and provide options to fix any errors, such as 
open loops, intersections, or overlapping entities. Directly from the feature wizards, 
you make the fixes, never leaving the 2D environment. 

AutobuildZ is integrated into Pro/ENGINEER Wildfire 2.0. Using the simple, but 
powerful suite of tools, you can now directly reuse your legacy 2D data in a 3D context. 
AutobuildZ serves as an excellent training tool. With AutoBuildZ, novice 2D users can 
learn about 3D solid modeling concepts and about feature building tools used in 
Pro/ENGINEER in the familiar 2D environment.  To learn more about AutobuildZ, 
visit the product pages on PTC.com. 

User Interface Location  

Tools / AutobuildZ (available in Drawing mode only 
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Foundation Advantage 

Detail Drawing 

Title  

Automatic Creation of Ordinate Dimensions for Parts 

Summary  

The automatic creation of ordinate dimensioning has been expanded to include all 
parts. 

Benefits and Description  (200words) 

Automatic ordinate dimensioning can now be used for more than just sheet metal. On 
parts, you can create ordinate dimensions quickly and easily. 

To use this command, select Insert > Dimension > Auto Ordinate, and select the 
surfaces you want dimensioned. Pro/E prompts you to select a baseline. After you select 
the baseline, the dimension is automatically created.  

User Interface Location  

Insert / Dimension / Auto Ordinate
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Foundation Advantage 

Assembly and Weld (Pro/PROCESS for Assembly) 

Title  

Assembly Feature Enhancements 

Summary  

Assembly features are widespread in the design process. Dimensions, axes, tolerances, 
and 3D notes of assembly cuts that intersect parts are now available in the part. 
Performance, memory usage, and regeneration order is improved.

Benefits and Description  (200words) 

Dimensions, axes, tolerances, and 3D notes associated with an assembly Hole feature 
that intersects a part can be displayed using the Show and Erase command on a 
drawing. This command eliminates the need to create these entity types manually. In 
Pro/NC, assembly-Hole feature axes are part of each hole and can be used for 
autodrilling and other NC tool paths. This eliminates the need to recreate the axis 
features in the Pro/NC model and significantly decreases the time it takes for NC 
programming. Stable, regeneration performance improves the usability of assembly 
features in the design process.

User Interface Location  

In the Intersect slide-up panel on the dashboard, select Default display level: Part 
Level / check mark Show Feature Properties in Sub-Models.
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Foundation Advantage 

Fundamentals (Fundamentals, Design Conferencing) 

Title  

Annotation Features

Summary  

Annotation features can add continuously displayed detail information to your 3D 
models.

Benefits and Description  (200words) 

Annotation features are “containers” where annotations (notes, dimensions, geometric 
tolerances (GTOLs), surface finishes, and so forth) can reside. They are made of 
entities called Annotation elements and are displayed parallel to a plane that is 
selected at the time of creation. Annotation features support the new ASME Y14.41 
standard for “Digital Product Definition Data Practices.” 

There are several benefits to using Annotation features: 

• Annotations that are specific to a role (manufacturing, quality, 
assembly, and so forth) can be grouped and displayed as necessary 

• Annotation features, as well as annotation elements, can have 
parameters 

• Annotation features exist in the Model Tree in the order of creation 

You can control the importance of annotation references. If an annotation is critical to 
the design of the model, the status of its reference can be made “strong.” If a strong 
reference is removed from the model, the Annotation feature dependent upon it will 
fail. If a reference is weak, the Annotation feature regenerates with the missing 
reference.  

Annotation features can be used in simplified representations and on layers. You can 
also create combined view states using a defined orientation and simplified 
representation that can be accessed quickly and easily.

User Interface Location  

Insert / Model Datum / Annotation
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Foundation Advantage 

Fundamentals (Fundamentals, Design Conferencing) 

Title  

Annotation Attachments in Shrinkage by Scaling 

Summary  

Shrinkage by scaling supports Annotation references. You can forward references to 
Shrinkage features using the By scaling command. 

Benefits and Description  (200words) 

When defining shrinkage by scale, you can forward references automatically to the 
Shrinkage feature. These references ensure that the details associated with the 
original part are forwarded to the new feature as necessary.  

The updated interface for creating shrinkage features includes dialog boxes for both 
the By scaling and By dimension commands. The dialog boxes simplify the 
definition of the shrinkage feature. To attach Annotation references to shrinkage 
features, select the Forward Reference check box while creating a Shrinkage feature 
using the By scaling command.  

User Interface Location  

Edit / Setup / Shrinkage / By scaling
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Foundation Advantage 

Simulation (Mechanism Dynamics, Design Animation) 

Title  

Animated Playback Enhancements 

Summary  

Animated playbacks in Mechanism Design, Mechanism Dynamics, and Design 
Animation allow for the display of datum curves in shaded mode and in 3D notes. 

Benefits and Description  (200words) 

You can generate animations to display critical information during playback.  

To support ASME Y14.41 and to allow them to be shown in graphical annotation 
planes, 3D notes now display while blanking, unblanking, and moving components 
during animated playback in Mechanism Design and Design Animation. 

This enhancement allows the display of datum curves during shaded animation as well 
as in wireframe animation, regardless of whether the component contains solid 
geometry.  

User Interface Location  

N/A
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Foundation Advantage 

Part Modeling (Part and Sketcher) 

Title  

Analysis User Interface  

Summary   

Curve and surface analysis tools increase usability and productivity in the design 
process with the user interface. 

Benefits and Description  .

The Curve and Surface analysis user interface reduces the complexity of the analysis 
process and makes every analysis available from a single mouse click. The result is an 
increase in productivity and ease of use. The Curve and Surface menus have been 
consolidated under Geometry analysis. The Geometry analysis tools have a more 
intuitive user interface with “smart defaults,” last-used values, direct edits, and 
dynamic updates within the Style and Restyle functional areas. Each Geometry 
Analysis tool has its own customizable icon, so you can to customize your working 
environment with the most commonly used tools for the job at hand.

User Interface Location  

Analysis / Geometry
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Foundation Advantage 

Data Exchange (ATB, DataDoctor, Interfaces) 

Title  

Efficient Import of 2D Data

Summary   

With the 2D Import dialogs (Import DXF, Import DWG, and Import IGES for 
DXF, DWG, and IGES respectively) boxes, you can configure and control the import 
of 2D into Pro/ENGINEER with a single user interface.

Benefits and 

Besides configuring and controlling imported 2D data, you can map fonts from the 2D 
file being imported or appended to available Pro/ENGINEER fonts. The user interface 
for the import of 2D data is context-sensitive to data types. You can control import 
options such as: 

• 2D views 
• Dimensions as associative dimensions 

• Variable-sized sheets 

The Import DXF, Import DWG, or Import IGES dialog box opens when opening a 
DXF, DWG, or IGES file respectively or when appending a DXF, DWG, or IGES file 
into a drawing, layout, diagram, or other format in Pro/ENGINEER.  

User Interface Location  

File / Open or Insert / Shared Data / From File (if a drawing, format, layout or diagram 
is active)
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Foundation Advantage 

Data Exchange (ATB, DataDoctor, Interfaces) 

Title  

Improved Multi-Line Text Support

Summary  

Improved control over the export and import of multi-line text expands and improves 
interoperability of Pro/ENGINEER with AutoCAD.

Benefits and Description  (200words) 

You can create a single multi-line text note in Pro/ENGINEER from a multi-line text in 
a 2D interface file. In addition, when you export a Pro/ENGINEER drawing to an 
AutoCAD DWG or a DXF file, you can create a single MTEXT (AutoCAD entity) entity 
for any multi-line text note in the Pro/ENGINEER drawing.  

User Interface Location  

File / Open
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Foundation Advantage 

Assembly and Weld (Pro/PROCESS for Assembly) 

Title  

Flexibility during Drag-and-Drop Component Assembly

Summary  

When assembling a component using drag-and-drop operations, you can specify the 
part flexibility without having to redefine the component later. 

Benefits and Description  (200words) 

Specifying flexibility during component assembly dramatically increases the workflow 
and ease-of-use during component placement. Additionally: 

• Dimension boundaries and surface finishes are available as varied items. 
• Changes in the flexible model can be propagated back to the original model.

User Interface Location  

Edit / Setup / Flexibility
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Foundation Advantage 

Part Modeling (Part and Sketcher) 

Title  

Directional and Axial Pattern Enhancement 

Summary  

The Pattern tool now has directional and axial pattern types for more flexibility in 
establishing directions for patterns. 

Benefits and Description  (200words) 

You can pattern features around an axis or in any direction, regardless of how the 
original pattern was created. Previously, a Make Datum feature was required for axial 
patterns to incorporate the angular dimension for patterning. Additionally, you can 
pattern any feature in any direction without having to select any dimensions as 
defined in the original feature. Pattern preview is also available for directional and 
axial patterns. The preview consists of dots to represent the center of the pattern 
member. You can select these dots to turn pattern instances on or off during the 
definition of the pattern. Pattern dimensions have drag handles to allow for on-screen 
manipulation of the pattern.

User Interface Location  

Edit / Pattern
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Foundation Advantage 

Assembly and Weld (Pro/PROCESS for Assembly) 

Title  

Real-Time Dragging of Packaged Components 

Summary  

In Assembly mode, you can kinematically drag packaged components in the remaining 
degrees of freedom, based on existing placement constraints. 

Benefits and Description  (200words) 

Design assemblies no longer require a skeleton or the reconstruction of assemblies in 
Mechanism to evaluate mechanism behavior. Basic dragging allows full interrogation 
of the assembly through its full range of motion, based on the degrees of freedom in the 
placement constraint. For a component with no placement constraint, you can move it 
into the vicinity of the assembly for placement. This capability vastly improves the 
workflow and usability of assemblies and mechanisms.

User Interface Location  

During component placement: Hold down CRTL+ALT and middle-click.
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Foundation Advantage 

Electrical Design (Diagram, Cabling, Harness,ECAD) 

Title  

ECAD Importing Improved

Summary  

The ability to control the importing of hole information using IDF 3.0 data has been 
improved.

Benefits and Description  (200words) 

When directly importing an assembly during the board creation process, you have a 
choice of hole filters. You can now automatically filter PIN holes when creating a 
board. During the import of IDF 3.0 data, the Hole Import list displays PIN, VIA, 
MTG, TOOL, and other information. 

By clicking Options on the ECAD – Import dialog box (available from the Import 
New Model dialog box), you can modify the selection of holes to import as required. 

There are two new configuration options: 

• ecad_pin_hole_import controls the default settings for the hole filter of type PIN. 
When the option is set to no (default), PIN holes within the IDF 3.0 file are not 
imported. 

• ecad_via_hole_import controls the default settings for the hole filter of type VIA. 
With the option is set to yes (default), VIA holes within the IDF 3.0 file are 
imported. 

User Interface Location  

N/A
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Foundation Advantage 

Fundamentals (Fundamentals, Design Conferencing) 

Title  

New Feature Move Tool 

Summary  

This new enhancement implements the Windows style Copy and Paste Special 
functionality to move and rotate features.

Benefits and Description  (200words) 

Users can now quickly and easily move, translate and rotate features  to other parts of 
the model using the already familiar Copy <CTRL-C> and Paste Special functions 
found in a majority of Windows based software applications.  Multiple transformations 
are now possible during the operation.  The moved features are now Editable allowing 
the user to redefine the transformation without having to recreate the moved features 
from scratch.  During the Paste Special operation, users have the ability to interact 
with the feature using the new dashboard and seeing immediate preview of the 
features being moved.  

User Interface Location  

Edit > Copy <CTRL>-c   and   Edit > Paste Special
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Foundation Advantage 

Detail Drawing 

Title  

Moving Dimensions While in the Show/Erase Dialog Box 

Summary  

The ability to adjust the location of dimensions without exiting the Show/Erase dialog 
box has been reinstated. 

Benefits and Description  (200words) 

Now you can pause the Show/Erase dialog box operations while showing dimensions. 
You can complete the task of showing dimensions without interrupting your workflow. 

To use this functionality, on the Show/Erase dialog box, show the dimensions. Right-
click to pause the show and erase tool. Adjust dimensions as necessary, and right-click 
again to resume operations.

User Interface Location  

While inside the Show/Erase dialog box, right-click to select the command to pause or 
resume the show and erase process.
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Foundation Advantage 

Model Analysis (BMX, ModelCHECK, Pro/PROGRAM) 

Title  

ModelCHECK Detailed Report (HTML) 

Summary  

ModelCHECK provides a new, static detailed report in HTML for Pro/ENGINEER 
data. The detailed report lists errors and warnings, and you can configure it to include 
other pertinent information from the data being checked. 

Benefits and Description  (200words) 

You can use the static, detailed report in HTML in other downstream applications. The 
different report types that can be generated follow: 
• Single part, assemblies, drawing summary report 
• Bill of materials (Assembly Component Models) summary report 
• Drawing and model summary report 

These static reports are generated from the ModelCHECK XML files generated when 
you run ModelCHECK. These XML files are filtered through a custom report template. 
You can edit this template to display additional data information in the report. 

User Interface Location  

N/A
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Foundation Advantage 

Model Analysis (BMX, ModelCHECK, Pro/PROGRAM) 

Title  

ModelCHECK Configurator Simplifies the Configuration Process 

Summary  

The ModelCHECK Configurator streamlines the configuration process of 
ModelCHECK. You can easily find, edit, and create new configurations and text files.  

Benefits and Description  (200words) 

Accessed through Pro/ENGINEER, the ModelCHECK Configurator makes it easy to 
create, find, and edit ModelCHECK configurations and files to meet company 
standards and best practices. The new user interface makes configuration easy with 
direct links to online Help. You can also scale the configurations, adding things like 
new checks and conditions, to conform to the current environment. 

User Interface Location  

Analysis / ModelCHECK / Configure ModelCHECK 
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Foundation Advantage 

Fundamentals (Fundamentals, Design Conferencing) 

Title  

New Mirror Tool 

Summary  

This new enhancement provides a new workflow to mirror geometry and features.

Benefits and Description  (200words) 

You can now mirror geometry and features for multiple transformations using one tool. 
The mirrored features can be created independently and the sketch of sketched-based 
features can be unlinked from the original. During the mirroring operation, you define 
the mirror definition using the already familiar dashboard. 

User Interface Location  

Edit / Mirror
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Foundation Advantage 

Simulation (Mechanism Dynamics, Design Animation) 

Title  

Joint Axis and Slot Friction

Summary  

Mechanism Dynamics incorporates the ability to apply frictional forces on joint axes 
and slot connections. Additions to measure types facilitate the inspection of applied 
friction force values.

Benefits and Description  (200words) 

For more accurate dynamic modeling of mechanisms, friction must be taken into 
account. You can now incorporate frictional influences within mechanism joints to 
appropriately simulate real-world behavior. Each editable joint axis has a friction 
coefficient specification enabled. With friction properties, joint friction forces are 
computed and applied to the joint axis in a direction opposite to the direction of motion 
in the joint. Joint axis friction is enabled for all editable joint axes, but does not 
consider coupling effects between multiple degrees of freedom in a particular 
connection.  

User Interface Location  

Application / Mechanism
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Foundation Advantage 

Assembly and Weld (Pro/PROCESS for Assembly) 

Title  

New Layer Functionality

Summary  

You can add items from lower-level subassemblies, collect layer items using the Layer 
Tree, and define rule-based layers to add and to remove layer items.  

Benefits and Description  (200words) 

• Assembly layers can now contain components from lower levels, eliminating the 
need to create same-named layers for all levels of subassemblies to control the 
display of subassembly components.  

• When selecting items using the object-action workflow, you can select layer items 
using the Layer Tree, which makes it easier to identify and select components from 
layers.  

• When defining rules for layers, use the template models to define the rules. Using 
rule-based layers previously defined in a model (part, assembly, or drawing), gives 
you additional flexibility with standards-based layer definition and assignment. 

User Interface Location  

From the Model Tree, click Show / Layer Tree.
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Foundation Advantage 

Fundamentals (Fundamentals, Design Conferencing) 

Title  

Annotations Support on Layers 

Summary  

Three-dimensional annotations, Annotation features, and Annotation Elements can be 
placed on layers. 

Benefits and Description  (200words) 

You can manage 3D annotations, Annotation features, and Annotation Elements by 
layers, using manual placement or by creating rules. 

To use this functionality, create a 3D annotation or an Annotation feature with a 
graphical element. Select a layer from the Layer Tree and edit the properties. You can 
add an annotation (or an Annotation Element) by selecting it from the graphics 
window or the Model Tree. To add an Annotation feature, select it from the Model Tree 
or select the Annotation Element from the graphics window, and then right-click and 
select Select Feature. You can also define a rule to automatically add the annotation 
to a layer. 

User Interface Location  

From the Layer Tree, select the layer, right-click and select Layer Properties from the 
shortcut menu. Select the item to be added or create a rule to automatically place the 
annotation on a specific layer.
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Foundation Advantage 

Other Functional Areas 

Title  

PTC.Setup Workflow Enhancements

Summary  

PTC.Setup has been redesigned to improve the installation workflow, to simplify the 
installation process, and to improve the speed of installation. The modern user 
interface provides additional ease of installation.  

Benefits and Description  (200words) 

PTC has redesigned PTC.Setup to consolidate screens and to remove unnecessary 
screens. The modern user interface simplifies the steps to install applications. From 
PTC License Manager to PTC Help, the new workflow in PTC.Setup makes installation 
easier. 

User Interface Location  

N/A 
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Foundation Advantage 

Fundamentals (Fundamentals, Design Conferencing) 

Title  

ProductView Express and Annotations

Summary  

Three-dimensional annotations created on an Annotation plane are viewable in 
ProductView Express. 

Benefits and Description  (200words) 

The ProductView Express preview browser shows all annotations in a model created 
using an Annotation plane. You can see the model, along with any annotations that are 
attached to it, in the preview window before you open or assemble the part. 

To use this functionality, browse to the folder where your model resides and select the 
model. The preview window will show your model, including all visible annotations. 
You can also see annotations in the preview window when you open a part.

User Interface Location  

N/A
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Foundation Advantage 

Fundamentals (Fundamentals, Design Conferencing) 

Title  

ProductView Express and UDFs with Stored Reference Models 

Summary  

In the preview window of the ProductView Express browser, you can view User-defined 
Features (UDFs) with their stored reference models.

Benefits and Description  (200words) 

Now you can see UDFs “as created” with their reference models in the preview window 
before you place them in the model. The preview window enables visual verification of 
the selected UDF before placement. 

To use this functionality, browse to the folder in which your UDF resides and select the 
GPH file. A preview of the UDF and the reference model appear in the window. 

User Interface Location  

ProductView Express preview window
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Foundation Advantage 

Data Exchange (ATB, DataDoctor, Interfaces) 

Title  

Multiple Sheet Sizes in the Import of DXF and DWG Drawings.

Summary  

The import of DXF and AutoCAD DWG files with multiple sheet sizes expands and 
improves the interoperability of Pro/ENGINEER with AutoCAD.

Benefits and Description  (200words) 

For the imported DXF or DWG drawing, you can either maintain the size of each sheet 
or use a standard Pro/ENGINEER sheet size (A4, A, C, and so forth) that is closest to 
the original sheet size. 

User Interface Location  

File / Open
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Foundation Advantage 

Part Modeling (Part and Sketcher) 

Title  

Offset Analysis 

Summary  

The Pro/ENGINEER suite of analysis tools includes an Offset Analysis tool for greater 
analysis of how curves and surfaces will offset downstream in the design process.

Benefits and Description  (200words) 

Offset Analysis, a new analysis type, provides dynamic visualization of the effects of an 
offset on curves and surfaces within Pro/ENGINEER. With Offset Analysis, you can 
clearly identify issues relating to shells, thicken operations, and so forth, early in the 
design process. Early identification of issues helps eliminate costly rework of offset 
issues late in the design process. 

User Interface Location  

Analysis / Geometry / Offset, and select the desired curve or surface for display.
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Foundation Advantage 

Sheetmetal (Design, NC) 

Title  

Flat Wall Feature 

Summary  

The Flat Wall feature consolidates and simplifies the creation of sheetmetal flat walls.

Benefits and Description  (200words) 

This feature offers the quickest and easiest way to create flat walls in sheetmetal using 
the object-action and action-object paradigm. It comes with industry-standard, 
predefined shapes for the walls (rectangular, trapezoid, L, and so forth). You can define 
your own section using standard Pro/ENGINEER sections. 

Direct manipulation of all standard shapes and types of wall relief is available through 
handles. Whenever necessary, automatic wall relief is added. 

Using the dashboard, you can flip the section side and the section thickness side. There 
are no constraints in the selection of the edge from which to generate any wall. 

User Interface Location  

Insert / Sheetmetal Wall / Flat or the new icon  in Sheetmetal mode
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Foundation Advantage 

Sheetmetal (Design, NC) 

Title  

Flange Wall Feature 

Summary  

The Flange Wall feature consolidates and simplifies the creation of sheetmetal 
extruded, swept, and hem walls.

Benefits and Description  (200words) 

This feature offers the quickest and easiest way to create flange walls along an edge on 
a sheetmetal part using the object-action and action-object paradigm. It comes with 
industry-standard, predefined shapes for the walls. You can define your own section 
using standard Pro/ENGINEER sections. 

Direct manipulation of all standard shapes and types of wall relief is available through 
handles. Wherever necessary, automatic wall relief is added. 

Using the dashboard, you can flip the thickness of the sections. There are no 
constraints in the selection of the edge from which to generate any wall.  

User Interface Location  

Insert / Sheetmetal Wall / Flange or click  in Sheetmetal mode
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Foundation Advantage 

Simulation (Mechanism Dynamics, Design Animation) 

Title  

Net Load Measure

Summary  

Net Load Measures have been enhanced in Pro/ENGINEER Wildfire 2.0 to provide greater 
control and reporting for total loads and loads applied by a force or torque. 

Benefits and Description  (200words) 

These new enhancements address the inconsistencies of the Connection Reaction 
Measure and the shortcomings of the Load Reaction measure. 

• These new measures will now calculate the total load acting at a joint. 
When a joint axis is subjected to more than one load (such as force 
motor, damper, spring etc), it is not possible to query the total load at 
that axis.  

• Connection Reaction Measure: Report the correct reaction value for 
axial force measures (on translational axes) and axial moment 
measures (on rotational axes) - This value should take into 
consideration the constraints (i.e. locking) created on the concerned 
joint axis and friction force if any. Any force entity present on the joint 
axis should not be transferred to the axis as a reaction as this will be 
measured as a Net Load and not as a reaction.  

• Net Load Measure: This measure was formerly called the Load 
Reaction measure. Accept Force, Torque and Joint Axis in the 
selection for a Net Load measure (in addition to Spring, Damper and 
Motor).  

User Interface Location  

Generate Measure Results / Create a New Measure / Type – Net Load
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Foundation Advantage 

Simulation (Mechanism Dynamics, Design Animation) 

Title  

Multiple-Measure Support

Summary  

Profiles of a servo motor, force motor, and force/torque have been enhanced to include 
more than one measure variable in the user-defined function definition. 

Benefits and Description  (200words) 

User-defined functions are used to define the profile of a servo motor, force motor, and 
force/torque. The functions consist of one or more expression segments and a domain 
associated with each of the expression segments. These functions can be defined by 
including arithmetic operators, mathematical functions, constants, and a variable.  

User-defined functions for servo motors are always a function of time. In contrast, 
user-defined functions for force motor and force/torque can be defined either as 
functions of time or measure variables. With multiple-measure support, you can build 
force motor and force/torque profiles with more than one measure variable in the user-
defined function definition. These functions enable complex force motor and 
force/torque profiles, which are dependent on multiple measures in a mechanism, to 
exist. 

User Interface Location  

Mechanism / Force Motors or Mechanism / Force/Torque  
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Foundation Advantage 

Surfacing (ISDX, Restyle, Warp, Facet Modeling) 

Title  

Spine Command  

Summary  

The Spine command provides a method of creating curve-based deformations to parts 
and sets of surfaces from native geometry to imported IGES files.

Benefits and Description  (200words) 

The Spine command provides an excellent means to make specific and highly complex 
deformations to a model. It is a powerful addition to the set of Warp tools. The spine 
deformation is a global, character-line reshaping and is based on a curve or a spine. 
When the spine is edited (via control points, tangents, and so forth), it influences the 
model around it. The spine can act in one of three directions (linear, cylindrical, or 
radial) and damping regions can be applied to localize the deformation. 

User Interface Location  

Warp / Spine  
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Foundation Advantage 

Other Functional Areas 

Title  

PTC.Setup Workflow Enhancements

Summary  

PTC.Setup has been redesigned to improve the installation workflow, to simplify the 
installation process, and to improve the speed of installation. The modern user 
interface provides additional ease of installation.  

Benefits and Description  (200words) 

PTC has redesigned PTC.Setup to consolidate screens and to remove unnecessary 
screens. The modern user interface simplifies the steps to install applications. From 
PTC License Manager to PTC Help, the new workflow in PTC.Setup makes installation 
easier. 

User Interface Location  

N/A 
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Foundation Advantage 

Part Modeling (Part and Sketcher) 

Title  

Reflection Analysis 

Summary  

The Reflection command for analysis provides visualization of the surface quality 
during the design process. You can visualize surface flow lines and identify problem 
areas early in the design process.

Benefits and Description  (200words) 

Reflection Analysis (or Zebra Striping) is a new analysis type for geometry analysis. 
Reflection Analysis shares the user interface for Curve and Surface Analysis. The 
command is also available from a shortcut menu. This dynamic method of analysis 
checks surface and connection quality within Pro/ENGINEER. 

User Interface Location  

Analysis / Geometry / Reflection. In the Reflection dialog box, select the surface patches 
of interest and the reflection analysis is displayed. 
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Foundation Advantage 

Rendering 

Title  

Reflection of the Environment on a Model 

Summary  

Environment mapping allows the environment, that is, room appearances, to be 
reflected in the model. 

Benefits and Description  (200words) 

Environment mapping not only provides an increased level of realism in realtime, but 
also allows you to quickly set up proper reflections before performing a higher quality 
static rendering. To use environment mapping, first apply desired textures to the room 
walls. After setting up the room, select View > Display Settings > Model Display, 
select the Shade tab from the Model Display dialog box, and select Realtime 
Rendering from the Enable area of the dialog box. Environment Mapping becomes 
available. The option to hide the environment (hide the room) also becomes available, 
so you can display model reflections without seeing the room reflections. 

User Interface Location  

Environment Mapping is located under the Shade tab in the Model Display dialog box. 
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Foundation Advantage 

Model Analysis (BMX, ModelCHECK, Pro/PROGRAM) 

Title  

Redesign of the RuleCHECK User Interface

Summary  

RuleCHECK, a component of ModelCHECK, has been redesigned to take advantage of 
the Pro/ENGINEER browser and to make RuleCHECK easier to use. RuleCHECK 
allows companies to easily document and enforce important engineering rules. 

Benefits and Description  (200words) 

With RuleCHECK, design information is made available in a proactive fashion and is 
integrated into the Pro/ENGINEER browser. The new user interface not only makes 
RuleCHECK compatible with ModelCHECK, but it also provides the ability to take 
advantage of dynamic HTML links to other pertinent information and makes it easy to 
use. 

As a design advisor, RuleCHECK offers immediate access to your company’s design 
knowledge. Often this information is stored in design manuals, industry design codes, 
and in the minds of senior designers. Engineers must know when and where to search 
for this information. Today, products are becoming more complex, design time is 
reduced, and there is considerable turnover and reorganization of engineering staff. 
Immediate access to correct and up-to-date engineering knowledge is critical to the 
success of many projects. 

User Interface Location  

Analysis / ModelCHECK / RuleCHECK 
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Foundation Advantage 

Surfacing (ISDX, Restyle, Warp, Facet Modeling) 

Title  

Sculpt Command 

Summary  

The Sculpt command provides a method for deforming a part or set of surfaces via a 
control mesh, greatly expanding the functionality within the Warp feature.

Benefits and Description  (200words) 

The control mesh for sculpted geometry can be located on any of the six faces of an 
imaginary bounding box that surrounds the area to be warped. You have full control 
over the density of the mesh via input to the dashboard. The sculpting action pulls on 
rows, groups, or individual mesh points. You can control the movement of the points to 
achieve the smoothest deformation and desired result and preserve symmetry while 
using the Sculpt command. You can view and edit the sculpt parameters outside of the 
feature, as with all other Warp types.

User Interface Location  

Warp / Sculpt 
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Foundation Advantage 

Fundamentals (Fundamentals, Design Conferencing) 

Title  

Reduced Regeneration Time with a Progress Bar  

Summary  

Regeneration times can be as much as 80% less for assembly models. You can view the 
progress of the regeneration with the Regeneration Progress bar.

Benefits and Description  (200words) 

Using Smart Regeneration technology within Pro/ENGINEER Wildfire, only features 
and components requiring regeneration because they are children of modified features 
are regenerated. In Part mode, shell, draft and surface Copy features are now checked 
and only regenerated as required. This smart regeneration saves time regenerating 
large, complex parts and assemblies. During regeneration, a progress bar shows the 
remaining time for the regeneration. In addition, scrolling text above the progress bar 
identifies the model and counts down the number of features left to be regenerated. 

User Interface Location  

Edit / Regeneration
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Foundation Advantage 

Fundamentals (Fundamentals, Design Conferencing) 

Title  

Reduced Regeneration Time with a Progress Bar  

Summary  

Regeneration times can be as much as 80% less for assembly models. You can view the 
progress of the regeneration with the Regeneration Progress bar.

Benefits and Description  (200words) 

Using Smart Regeneration technology within Pro/ENGINEER Wildfire, only features 
and components requiring regeneration because they are children of modified features 
are regenerated. In Part mode, shell, draft and surface Copy features are now checked 
and only regenerated as required. This smart regeneration saves time regenerating 
large, complex parts and assemblies. During regeneration, a progress bar shows the 
remaining time for the regeneration. In addition, scrolling text above the progress bar 
identifies the model and counts down the number of features left to be regenerated. 

User Interface Location  

Edit / Regeneration
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Foundation Advantage 

Fundamentals (Fundamentals, Design Conferencing) 

Title  

Regeneration Footer 

Summary  

Entities that are always created or evaluated at the end of the feature list are 
automatically placed into the regeneration footer. 

Benefits and Description  (200words) 

Some entities are evaluated at the end of regeneration regardless of their position in 
the Model Tree. A new section in the Model Tree clarifies the organization of 
information. Items with no real dependency on their position within the Model Tree are 
automatically placed into the regeneration footer, for example, a zone. Zones are 
always evaluated at the end of regeneration and cannot be referenced by other 
features.  

Some features in the active Model Tree can be moved to the footer. For example, if you 
want a published geometry, data-sharing feature to always be evaluated at the end of 
regeneration, you can move it to the footer after creation. 

To use this functionality, select the item to be moved into the footer, right-click and 
select Move to footer from the shortcut menu. To remove an item from the footer, 
expand the footer, select the item, and right-click and select Move from footer.

User Interface Location  

Model Tree beneath Insert Here 
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Foundation Advantage 

Part Modeling (Part and Sketcher) 

Title  

Completed the Curve Wrap Tool 

Summary  

The curve Wrap Tool now provides a streamlined workflow and additional functionality  
for creating wrapped curves.  

Benefits and Description  (200words) 

The Wrap Tool for datum curves now prevents the feature failure when the parent 
geometry is redefined from a surface to a solid.  The Preview of the geometry during 
curve creation has been dramatically improved particularly with sketches contain text.  
The additional functionality includes being able to wrap separated curves on connected 
surfaces and the portion of the curve that cannot be wrapped has the option to be 
trimmed.   

User Interface Location  

Edit / Wrap
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Foundation Advantage 

Assembly and Weld (Pro/PROCESS for Assembly) 

Title  

View Manager Includes Cross Sections and Zones 

Summary  

The View Manager is a powerful tool for managing and easily switching between 
simplified representations, explode states, orientation, component display states, and 
now zones and cross sections.

Benefits and Description  (200words) 

The consolidation of all the viewing states of a model into one centralized location 
dramatically improves the workflow and usability of the various viewing tools. Within 
the View Manager, it is now possible to capture views in one saved “All State.” This All 
State represents the combination of a simplified rep, in a specific orientation with some 
components shaded and others in wireframe, showing a cross section and several 
components exploded. This All State is available for design reviews, product 
documentation, or vendor meetings.

User Interface Location  

View / View Manager
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Foundation Advantage 

Fundamentals (Fundamentals, Design Conferencing) 

Title  

Feature Verify Improvements 

Summary  

Feature Verify is now easier to use. 

Benefits and Description  (200words) 

During feature creation, when selecting feature Verify (eyeglasses in the dashboard), 
Pro/ENGINEER will regenerate the feature and display it on the model.  At this point, 
the user can interrogate the current feature in the model using the Analysis tools to 
measure any geometry item of interest.  This makes it easy for the user to know that 
the feature is correct and right before finishing the feature creation and regenerating 
the remainder of the mode.  To exit Verify, the option Exit Verify is now available 
using the Right Mouse Button (RMB).   

User Interface Location  

Press the Eyeglasses Icon in the Dashboard during Feature Creation
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Foundation Advantage 

Part Modeling (Part and Sketcher) 

Title  

Improved Workflow for Variable Section Sweep Features 

Summary  

Users can now create Variable Section Sweep features using an improved and more 
streamline workflow within the tool. 

Benefits and Description  (200words) 

The improved workflow for Variable Section Sweep features is now easier to 
understand and provides a smoother workflow.  Feature drag handles are now 
available for use during feature creation.  The feature node in the Model Tree has also 
been updated with a new icon and a new feature type description to make it easier for 
the user to recognize.  Graphical highlighting for tangent trajectories provides the user 
with immediate feedback during feature creation.  The option to split surfaces using 
trip, allowing the user to keep both sides of the feature adds to the power of the 
Variable Section Sweep feature. 

User Interface Location  

Insert > Variable Section Sweep
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Foundation Advantage 

Fundamentals (Fundamentals, Design Conferencing) 

Title  

Annotations in Inheritance Features 

Summary  

With various annotations and Annotation elements in inheritance features, you can 
vary the surface-finish values. You now have greater control over the status of copied 
inherited annotations.

Benefits and Description  (200words) 

Improved definition of inheritance features provides additional options and more 
control over annotations. Inheritance features now support variable surface-finish 
values. Additional controls are provided for the copy status of geometric tolerances 
(GTOLs), surface finishes, notes, and symbols. Annotation features are also supported 
in inheritance features with the same controls for Annotation Elements: 

• Variable surface-finish values–Specifies a new value for surface 
finishes included in inheritance features 

• Additional copy status control–Controls the copy status of the 
individual annotations from the source model. You can copy all 
annotations, exclude all annotations, or select the annotations you 
would like copied into the inheritance feature. 

To use these functionality improvements, create an inheritance feature and select 
Var Annotations to configure the annotations. The new options are located in the 
Var Annotations section. 

User Interface Location  

Insert / Shared Data / Inheritance from other model / Var Annotations
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Foundation Advantage 

Model Analysis (BMX, ModelCHECK, Pro/PROGRAM) 

Title  

ModelCHECK as a Gatekeeper for Windchill

Summary  

Windchill now uses ModelCHECK as the gatekeeper to the Windchill database. 
ModelCHECK helps verify that the checked-in data is of good quality and meets 
company specifications. 

Benefits and Description  (200words) 

ModelCHECK promotes the use of company standards and best practices to improve 
the effectiveness of downstream design reuse. With this new enhancement to 
Windchill, the ModelCHECK Gatekeeper is used to help filter out data that is being 
check-in into the Commonspace that does not meet company standards or best 
practices.  

Companies can configure a unique ModelCHECK Gatekeeper filter to define the 
requirements for a successful check-in into the Commonspace. For each lifecycle state, 
companies can control the density of the filter by selecting the Gatekeeper to check for 
various ModelCHECK read-only parameters or for modification of the data. 
 
During the check-in process, ModelCHECK Gatekeeper completes the check-in for data 
that meets the established requirements, or limits the check-in if any of the 
components do not pass the check. If the check-in fails, Windchill reports back the 
data’s particular errors and warnings. 

User Interface Location  

File / Check-in
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Foundation Advantage 

Fundamentals (Fundamentals, Design Conferencing) 

Title  

Specification of Units for Parameters 

Summary  

Units can be specified for user-defined parameters during creation and when using 
parameters in relations. Parameter units are recognized and supported by 
Pro/INTRALINK and PDMLink. 

Benefits and Description  (200words) 

Specify parameters as unitless or with units during their creation or when using them 
in relations. If of differing units, parameters in relations are scaled correctly based on 
calculations. For example, if the model units are in millimeters the relation 
TOTAL_LENGTH = 1 [in] + 5[mm] would evaluate TOTAL_LENGTH = 30.4[mm]. This 
scaling dramatically increases the flexibility and power for defining custom units. You 
can mix units when writing relations without having to convert the parameter values 
before using them. Scalar, or unitless parameters, are still supported and can be used 
with parameters with units in relations.  

User Interface Location  

Tools / Parameters / Properties
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Foundation Advantage 

Detail Drawing 

Title  

Undo/Redo Functionality for Drawings 

Summary  

Undo/Redo functionality is now supported in Pro/ENGINEER. Users will have the 
ability to quickly undo or redo selected commands in drawings.  

Benefits and Description  (200words) 

Undo/Redo functionality in drawings gives you the ability to quickly undo (or redo) 
accidental changes to drawings. This eliminates the need to manually re-create items 
that may have been accidentally deleted or moved. The first implementation of 
undo/redo functionality will be limited to selected commands. The commands in 
drawings are divided into 3 categories: Supported commands, unsupported commands 
that clear the stack, and unsupported commands that do not clear the stack. Supported 
commands are actions that can be undone and redone. Examples of these commands 
are: insert>dimension and moving a drawing view. To prevent the user from 
unintentionally undoing an action that was executed before several unsupported 
commands, there are some actions that clear the stack. Examples of these types of 
commands are File>Open and Format>Text Style. Unsupported commands that do not 
clear the stack are essentially invisible to undo/redo. These commands are those that 
have no real impact to the drawing itself, like changing the size of the working window 
and viewing commands. Full details of the supported commands can be found in the 
help documentation. 

User Interface Location  

Edit>Undo OR Edit>Redo
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Foundation Advantage 

Part Modeling (Part and Sketcher) 

Title  

Expanded Trim Tool Functionality  

Summary  

Additional functionality has been added to the Trim Tool to allow for a better, more 
streamlined workflow when trimming surface and curve geometry. 

Benefits and Description  (200words) 

The Trim Tool now provides access to full chain selection when selecting geometry to 
use in the trim operation.  Additionally, the user now has the silhouette trim 
functionality as part of the Trim feature dashboard.  The feature preview visibility has 
also been enhanced to provide a better visual of the feature during definition.        

User Interface Location  

Edit > Trim
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Foundation Advantage 

Simulation (Mechanism Dynamics, Design Animation) 

Title  

Transparency at Animation Time 

Summary  

Design Animation has been improved so you can define the transparency for assembly 
or its components at various animation times. 

Benefits and Description  (200words) 

Design Animation supports the display of components using various display styles, 
such as wireframe, shaded, hidden-line, and so forth, at various animation times. You 
can now set the transparency of the components to visible or invisible. This becomes 
valuable when the motion of the components inside another component must be 
animated. To better visualize the motion of the inner components, you can fade the 
outer components. 

User Interface Location  

Animation / Trans @ Time
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Foundation Advantage 

Simulation (Mechanism Dynamics, Design Animation) 

Title  

System and Body Measures 

Summary  

System measures and Body measures have been added to Mechanism Design and 
Mechanism Dynamics. These measures generate additional information from either a 
dynamic or kinematics analysis.  

Benefits and Description  (200words) 

After you define the System and Body measures, you can monitor behavior throughout 
the dynamic or kinematics analysis.  

• Body—Measures several quantities that describe the behavior of a 
selected body. You can monitor the behavior of a body within the 
overall mechanism system.  

• System—Measures several quantities that describe the behavior of 
the entire system. You can use the results as objectives in design 
studies or include them in more complex expressions or in 
computed measures. 

 

User Interface Location  

Generate Measure Results / Create a New Measure / Type – System or Body
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Advanced Assembly Extension (AAX) 

Assembly and Weld (Pro/PROCESS for Assembly) 

Title  

Inheritance Feature Enhancements 

Summary  

Building on its powerful and robust features, the enhanced Inheritance Features (IF) 
functionality provides easier access and more flexibility in a design.  

Benefits and Description  (200words) 

You access the subfeatures within an Inheritance feature by selecting them from the 
graphics window or by using the new Search Tool. You no longer must choose the 
features from the Model Tree. When creating external Inheritance and external Merge 
and Cutout features, you can use placement constraints expanded from CSYS to CSYS 
to all existing placement constraints found in Assembly. 

User Interface Location  

Insert / Shared Data / Inheritance from Other Model
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Interactive Surface Design Extension II (ISDXII) 

Surfacing (ISDX, Restyle, Warp, Facet Modeling) 

Title  

Copy Proportional Command 

Summary  

An enhancement to the Copy command inside Style allows copied curves to be scaled 
proportionally. 

Benefits and Description  (200words) 

The Copy Proportional command operates on free and planar Style curves in the 
current feature. During the operation, you have dynamic, visual feedback with respect 
to the size and shape of the geometry.

User Interface Location  

Select a curve, select Edit / Copy Proportional, and arrows connect the start and end 
points of the original and copied curves. Drag the arrowheads to achieve the desired 
shape.
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Interactive Surface Design Extension II (ISDXII) 

Surfacing (ISDX, Restyle, Warp, Facet Modeling) 

Title  

Composite Surface Creation 

Summary  

You can select compound strings of curves to be treated as a single boundary edge 
during surface creation within Style.

Benefits and Description  (200words) 

All Style surfaces can use compound curves as boundaries. This ability extends the use 
of Style surfaces by allowing increased use of sketched curves as well as compound 
strings of Style curves. The compound curve elements, however, must be at least 
tangent continuous. 

User Interface Location  

Hold down SHIFT while selecting the desired segments during the boundary curve 
selection while creating a surface.
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Interactive Surface Design Extension II (ISDXII) 

Surfacing (ISDX, Restyle, Warp, Facet Modeling) 

Title  

4-View Enhancements in Style 

Summary  

In 4-view mode in Style you can dynamically resize four panes, allowing for a more 
usable work area while designing.

Benefits and Description   

Changing the size and aspect ratio of the panes allows you to have one relatively large 
“primary” pane and use the other three as references from time to time. 

User Interface Location  (10-20 

To resize the panes, drag the horizontal or vertical sashes, or drag the splitter where 
these two sashes meet. Double-click the sashes to reset them.
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Interactive Surface Design Extension II (ISDXII) 

Surfacing (ISDX, Restyle, Warp, Facet Modeling) 

Title  

Loft and Blend Surfaces 

Summary  

Loft and Blend surfaces in Style provide an additional and powerful tool set for 
creating complex forms.

Benefits and Description  (200words) 

Loft surface allows a Style surface to be created with a number of curves (two or more), 
defining the shape in one direction and no curves in the secondary direction. The Blend 
surface allows the creation of a surface from one or two guide curves and any number 
of profiles. 

User Interface Location  

To create a loft curve, select the Surface tool, select the segments in one direction and 
complete the loft surface. To create a blend surface, follow the steps for creating a loft, 
and then select Cross curve from the dashboard, collect the desired cross curves, and 
complete the blend surface.
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Interactive Surface Design Extension II (ISDXII) 

Surfacing (ISDX, Restyle, Warp, Facet Modeling) 

Title  

Planar on Endpoints Command 

Summary  

With the Planar on Endpoints command, you can make 3D curves temporarily 
planar without constraining them to a particular reference.

Benefits and Description  (200words) 

The curve becomes planar between its endpoints normal to the active datum plane. 
This functionality is only valid for free curves. Free tangents at the endpoints are 
adjusted if necessary. If any point or tangent constraints exist, the command does not 
affect the curve.

User Interface Location  

Select a curve, select the Edit tool, right-click the curve, and choose Planar on 
Endpoints from the shortcut menu.
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Interactive Surface Design Extension II (ISDXII) 

Surfacing (ISDX, Restyle, Warp, Facet Modeling) 

Title  

Offset COS Command 

Summary  

Curve On Surface (COS) curve offsets are now supported inside the Style functional 
area.

Benefits and Description  (200words) 

COS curves can be offset either on the surface or on the normal to surface, making this 
a powerful function. Offset curves are history-based and update whenever the original 
COS is modified and can be redefined to alter their direction or dimension. You can set 
offset dimensions via the dashboard for use in other areas of Pro/ENGINEER.

User Interface Location  

Select the curve to offset, select Styling / Offset COS and set the options in the 
dashboard.
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Interactive Surface Design Extension II (ISDXII) 

Surfacing (ISDX, Restyle, Warp, Facet Modeling) 

Title  

Radial-Path Planar Curves 

Summary  

An option to build radial-path, planar curves has been added to the Planar Curve tool. 

Benefits and Description  (200words) 

Within Style, you can construct a planar curve on a plane that remains normal to the 
tangent vector of a previously created curve at a specific location to build a radial path. 
The new plane and curve maintain their history, so that when you modify the path 
curve the geometry updates. You can also drag the plane along the path curve. 

User Interface Location  

Select the curve creation tool, toggle the curve type to planar, select the Refs tab from 
the dashboard, select reference and pick a point on the path curve. A plane will be 
constructed and its grid displayed. Click points on the plane to create the planar curve. 
When editing the curve, you can drag the plane along the path curve by holding down 
ALT, as you would to offset any planar curve reference plane dynamically.
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Behavioral Modeling Extension (BMX) 

Model Analysis (BMX, ModelCHECK, Pro/PROGRAM) 

Title  

User defined input for multi-objective design studies 

Summary  

Users can now explicitly specify the locations at which experiments will be performed 
in multi-objective design studies.

Benefits and Description  (200words) 

In past releases BMX determined the design space for multi-objective design studies 
(MODS) by uniformly distributing experiments between the users specified maximum 
and minimum values.   

In Wildfire 2.0, in addition to the current method of defining the design space, users 
may also specify a table of values at which they want experiments to be performed. The 
values for the design variable can be manually entered, or they can be imported from a 
text file.  You then have the option of running experiments on all of the combinations of 
design variables, or one experiment per “row” of design variable values. 

This new functionality makes MODS vastly more powerful than before, and opens the 
door to discrete optimization (for example optimizing a sheet metal assembly varying 
between fixed gauges of material) as well as using more advanced distribution 
functions, such as a Gaussian distribution.

User Interface Location  

Analysis->Multi-Objective Design Study
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Cabling Design Extension 

Electrical Design (Diagram, Cabling, Harness,ECAD) 

Title  

XML Data and Routed Systems Designer

Summary  

With a new menu item, Pro/CABLING provides for import of XML data from Routed 
Systems Designer. 

Benefits and Description  (200words) 

The selection of logical data created in Routed Systems Designer has been made 
simpler. On the new menu, you can set the import filter automatically to *.XML to 
filter out other file types and reduce the number of mouse clicks.

User Interface Location  

Logical Ref / Import / RS Designer 
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Cabling Design Extension 

Electrical Design (Diagram, Cabling, Harness,ECAD) 

Title  

Flattening of Closed Loops

Summary  

Automation for the flattening of closed loops has been simplified.

Benefits and Description  (200words) 

During the flattening process, any closed loop is highlighted and you are prompted for 
a preferred path. After the main harness has been flattened, you can choose to go back 
and close the loops. Select two locations, and the loops are closed.

User Interface Location  

Flatten / Lay Out / Close Loop 
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Cabling Design Extension 

Electrical Design (Diagram, Cabling, Harness,ECAD) 

Title  

Significant Locations Only and Flattened Harnesses

Summary  

Stability and performance has improved for the flattening of harnesses with the 
consideration of only significant locations.  

Benefits and Description  (200words) 

Considering only significant locations during the flattening of 3D harnesses reduces 
risk of failures, decreases rework after modifications, and improves stability and 
performance. Pro/HARNESS for manufacturing considers the following locations as 
significant: 

• Connector locations–Locations at the entry port of connectors 
• Transitional locations–Locations where the wire(s) and/or bundles 

are not the same on both sides 
• Branch locations–Locations where wires or bundles (one or more) 

do not share the same adjacent location 

User Interface Location  

N/A 
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Piping Design Extension 

Piping (Spec Driven, Non-Spec Driven) 

Title  

Routing of Flexible Pipes 

Summary  

You can route flexible pipes using 2D logical information in Spec-Driven Piping.  

Benefits and Description  (200words) 

This routing operation uses schematic information generated in Routed Systems 
Designer for the creation of the 3D flexible pipes within spec-driven piping. Use of this 
information reduces errors often caused by the manual interpretation of 2D schematic 
data. 

To use the schematic data from Routed Systems Designer, you must set the 
config.pro option piping_schematic_driven to yes. 

User Interface Location  

Pipeline / Create

 

 



What’s New for Pro/ENGINEER Wildfire 2.0 
Formerly Interactive Release Notes 

 

Piping Design Extension 

Piping (Spec Driven, Non-Spec Driven) 

Title  

Improved Pipe Weight Calculation  

Summary  

You can specify the density units of a pipeline independent of an assembly’s density 
units. 

Benefits and Description  (200words) 

Accurate mass property calculations for pipelines consisting of multiple materials are 
now possible. 

User Interface Location  

N/A
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Piping Design Extension 

Piping (Spec Driven, Non-Spec Driven) 

Title  

Enhanced Fitting Libraries 

Summary  

Over 12,000 library fittings, both JIS and ANSI, have been updated.  

Benefits and Description  (200words) 

The updating of the JIS and ANSI fitting libraries takes advantage of the 
improvements made to Pipe and Fitting weight calculations. If you use these fitting 
libraries, you are saved any rework.

User Interface Location  

N/A
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Piping Design Extension 

Piping (Spec Driven, Non-Spec Driven) 

Title  

Improved Weight Calculation for Fittings 

Summary  

You can obtain accurate mass property information without having to accurately model 
fittings.

Benefits and Description  (200words) 

To reduce library setup time and improve performance, user-defined parameters allow 
mass property information from vendor’s data sheets, which are added and stored with 
a fitting.  

Set pro_mp_source to parameters and add any of the user parameters to a fitting. 
This process provides enough information so that the Model Analysis functionality can 
calculate the user value for mass property calculations.  

User Interface Location  

N/A
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Design Collaboration Extension (DCX) 

Fundamentals (Fundamentals, Design Conferencing) 

Title  

Design Conferencing via a Data Management Tool

Summary  

During a real-time design session with Pro/ENGINEER, peer-to-peer Design 
Conferencing provides a data management system as the data source. This new option 
extends the capability of design conferencing and provides the security and control of 
the data management system. 

Benefits and Description  (200words) 

As a Design Conferencing participant, you can work with information stored in data 
management systems as well in the shared space. You can retrieve, save, and upload 
models, drawings, and so forth directly to and from the Commonspace or Cabinets 
during a conference. The conference host, called the PDM Master, grants access and 
privileges that can be updated at any time for security. 

As in traditional conferencing, an observer can get control from the PDM Master and 
become the current presenter. When others are presenters beside the host (PDM 
Master), all PDM transactions are performed on the PDM Master’s computer. All 
participants can observe the PDM transaction during the shared session, and the data 
is transferred to the participants’ shared space via the PTC Conference Center.  

User Interface Location  

N/A 
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Design Collaboration Extension (DCX) 

Fundamentals (Fundamentals, Design Conferencing) 

Title  

Design Conferencing User Account Login

Summary  

The PTC Conference Center has an improved method of logging in through a list of 
accounts for a specified Conference server. 

Benefits and Description  (200words) 

To use Design Conferencing, you must have a Design Conferencing account on the 
specified Conference server to log in to the PTC Conference Center on the local 
machine.  

When you start the PTC Conference Center for the first time on the specified 
Conference server, you must create a Design Conferencing account. If you already have 
an account on the local Conference server, you can log in to the Conference Center 
using your account name and password. To improve the login process, a User Name 
list provides all the accounts for the specified Conference server. The first account 
name on the list is the last person who had logged into the PTC Conference Center. 

User Interface Location  

Standalone Conference Center or Applications / Conference 
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Design Collaboration Extension (DCX) 

Fundamentals (Fundamentals, Design Conferencing) 

Title  

Design Conferencing Participant License Package

Summary  

Globally dispersed product development teams must collaborate from many locations. 
With the Pro/ENGINEER Design Conferencing Participant license package, even those 
without a license can participate in live design sessions. 

Benefits and Description  (200words) 

With more companies outsourcing jobs to minimize costs, time to market, and so forth, 
more people off site get involved in the design process. Powered by Groove Networks, 
Pro/ENGINEER Design Conferencing Participant is fast, flexible, and secure.  

With this license package, even those who do not own or have access to a license of 
Pro/ENGINEER can still participate in live design sessions. Once connected, a Design 
Conferencing Participant can perform all critical functions, like sharing control of live 
design sessions with their team, no matter where team members are located. 

User Interface Location  

N/A
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Design Collaboration Extension (DCX) 

Fundamentals (Fundamentals, Design Conferencing) 

Title  

Pop-up Menu Enhancements during Design Conferencing

Summary  

During a real-time design session with Pro/ENGINEER, pop-up menus allow observers 
to follow more closely with the steps and selections of the presenter. 

Benefits and Description  (200words) 

Peer-to-peer Design Conferencing provides the ability to conduct real-time, peer-to-
peer, multiuser design conferences with other Pro/ENGINEER users via the Web. Any 
number of participants can join the conference. The leader starts the shared session 
and can pass control over Pro/ENGINEER to any participant, who becomes the 
presenter. When the presenter performs an action in Pro/ENGINEER, everyone’s 
session follows along accordingly. 

Conferencing can be used for many types of situations, like training and holding design 
reviews. With these new enhancements, observers are able to follow every move of the 
presenter, from menus selected or commands executed from the Model Tree, to 
commands executed via the right-mouse button. This brings observers one-step closer 
to feeling as if they were in the same room as the presenter, working on the same 
machine. 

User Interface Location  

N/A 
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Reverse Engineering Extension (REX) 

Surfacing (ISDX, Restyle, Warp, Facet Modeling) 

Title  

Automatic Surfacing 

Summary  

Automatic surfacing in the Restyle functional area provides a simple, progressive 
means for creating surfaces. This functionality is ideal when working with extremely 
complex, organic shapes.

Benefits and Description  (200words) 

The Auto-Surfacing tool automatically generates the curve-patch structure as well as 
the surfaces directly on a facet model. The Auto-Surfacing dashboard includes three 
phases: 

• Include or exclude geometry for surfacing. 
• Select or create the curve patch structure. 
• Generate surfaces based on the selected curve network. 

 This dashboard-driven functionality provides an extremely quick method to create a 
surface representation of complex facet models and requires little experience.

User Interface Location  

Select the Auto Surface icon to open a dashboard.
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Reverse Engineering Extension (REX) 

Surfacing (ISDX, Restyle, Warp, Facet Modeling) 

Title  

Surface Connections for Curvature (G2) 

Summary  

The ability to create surface connections for curvature (G2) within the Restyle module 
greatly enhances workflow and flexibility while designing with surfaces. 

Benefits and Description  (200words) 

You can create a surface connection for surfaces that are tangent continuous across the 
boundary and share curvature along the common boundary. The user interface for this 
new constraint type streamlines workflow. Connection constraints in the 
Pro/ENGINEER window are designated by a dashed line (Positional), a single line 
(Tangent), and a double line (Curvature continuous). To access and modify connection 
information, right-click the selected surface, and choose the display constraint from the 
shortcut menu. Select the yellow indicator, right-click, and choose the desired 
constraint type from the shortcut menu.

User Interface Location  

Select the desired Surface, right-click and choose display constraints, select the yellow 
indicator, and choose the desired constraint type from the shortcut menu. 
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Tool Design Option (TDO) 

Mold Design and Casting 

Title  

Inherited Model as a Reference Part 

Summary  

As a Mold Designer, you can select an inherited model as a reference part for the mold 
assembly. The inherited model provides additional flexibility and control over the 
reference model. 

Benefits and Description  (200words) 

Using an inherited model as a reference model for a mold assembly, you can apply 
shrinkage on this reference model without affecting the initial model. In addition, you 
have access to all the flexibility of the inherited model in terms of the control of 
features and dimensions and the propagation of changes from the initial part. 

User Interface Location  

Mold Model / Assemble / Ref Model / …select and assemble the reference model … 
select Inherited
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Structural and Thermal Simulation 

Simulation (Mechanism Dynamics, Design Animation) 

Title  

Coordinate System Display in Result Windows

Summary  

Coordinate systems used in the creation of your model can now be displayed in result 
windows. 

Benefits and Description  (200words) 

The coordinate system display icons (Cartesian, cylindrical, and spherical) used in the 
definition of your model can now be seen in results. The coordinate system icon is 
displayed in the results window for fringe, vector, and model type. The icons can be 
toggled on or off using the Format > Result Window dialog box. 
The display of coordinate systems in result windows makes it easier for you to 
document and communicate your analysis model with others.

User Interface Location  

Format / Result Window
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Structural and Thermal Simulation 

Simulation (Mechanism Dynamics, Design Animation) 

Title  

Combined point, edge, and surface force/moment load definition

Summary  

Point, edge, and surface force/moment load definition commands have been merged 
into a common dialog.

Benefits and Description  (200words) 

The three different force/moment load commands for point, edge, and surface types 
have been merged into a single dialog.  This simplifies the user interface by reducing 
the number of toolbar commands and menus.  It also makes it possible to edit a load 
from one reference type to another; this was not possible in previous releases.

User Interface Location  

Insert -> Force/Moment Load
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Structural and Thermal Simulation 

Simulation (Mechanism Dynamics, Design Animation) 

Title  

Combined point, edge, and surface displacement constraint definition

Summary  

Point, edge, and surface displacement constraint definition commands have been 
merged into a common dialog.

Benefits and Description  (200words) 

The three different displacement constraint commands for point, edge, and surface 
types have been merged into a single dialog.  This simplifies the user interface by 
reducing the number of toolbar commands and menus.  It also makes it possible to edit 
a constraint from one reference type to another; this was not possible in previous 
releases.

User Interface Location  

Insert -> Displacement Constraint
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Structural and Thermal Simulation 

Simulation (Mechanism Dynamics, Design Animation) 

Title  

Bolt fasteners in Structural and Thermal

Summary  

Bolt fasteners have been added to Structural and Thermal simulation.

Benefits and Description  (200words) 

Modeling bolt used to be a long and tedious process that required a lot of experience 
and patience to master.  In Wildfire 2.0, a new modeling entity has been introduced 
which makes this much easier, the bolt fastener. 
 

It is now possible to define bole fasteners in assemblies simply by selecting the holes 
that will be held together by the fastener, and specifying a material and bolt diameter.  
Advanced fasteners may have their stiffness specified by spring properties, as well as a 
bolt pre-load value.  Three types of bolt fasteners are supported.  These include: 

 
• Through bolts in solid models 
• Through bolts in shell models 
• Blind (screw) fasteners in solid models

User Interface Location  

Insert -> Connection -> Fastener
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Structural and Thermal Simulation 

Simulation (Mechanism Dynamics, Design Animation) 

Title  

AutoGEM meshing over small geometry

Summary  

You may now specify a minimum edge length below which AutoGEM will ignore 
geometry features, simplifying your model.

Benefits and Description  (200words) 

When performing analysis of large, complex models it is often desirable to make the 
model mesh with fewer elements.  In the past, you accomplished this by de-featuring 
the geometry of the model.   This was time consuming and difficult.   

In Wildfire 2.0, it is now possible to define a minimum edge length AutoGEM control.  
In defining this mesh control you to specify a minimum length by either a dimensional 
value or percentage of the model.  When the AutoGEM mesh is being created, any 
geometry edges that fall below that specified in the mesh control will be ignored.  This 
gives you the ability to significantly reduce the number of elements required to mesh 
complex models such as castings and forgings. 

Using this new mesh control you will find it easier and quicker to simplify your models, 
which is useful when looking for global responses such as displacements or modal 
frequencies.

User Interface Location  

AutoGEM -> Control
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Structural and Thermal Simulation 

Simulation (Mechanism Dynamics, Design Animation) 

Title  

AutoGEM nodes on edge mesh control

Summary  

You may now specify the minimum number of nodes created on an edge in AutoGEM 
using the new AutoGEM mesh controls. 

Benefits and Description  (200words) 

Experienced users occasionally want to exert control over the mesh that is created in 
AutoGEM.  In past releases the only option was to modify the AutoGEM settings 
(which impact the model globally) or modify the geometry by adding points or curves.  
In Wildfire 2.0, you may now simply create a Nodes on Edge mesh control where you 
specify the number of nodes AutoGEM will create on a given curve/edge.  This makes it 
much easier to create a refined mesh you are happy with.

User Interface Location  

AutoGEM -> Controls

 

 



What’s New for Pro/ENGINEER Wildfire 2.0 
Formerly Interactive Release Notes 

 

Structural and Thermal Simulation 

Simulation (Mechanism Dynamics, Design Animation) 

Title  

AutoGEM performance and robustness improvements

Summary  

AutoGEM meshing performance has been improved by up to 25%.  Thin model meshing 
robustness has also been improved.

Benefits and Description  (200words) 

AutoGEM performance has been improved by up to 25% for solid meshing.   
Additionally, the robustness of solid meshing large thin models has been greatly 
improved.

User Interface Location  

AutoGEM -> Create
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Structural and Thermal Simulation 

Simulation (Mechanism Dynamics, Design Animation) 

Title  

Display of AutoGEM Mesh in Integrated Mode 

Summary  

More options have been added to control the display of the AutoGEM mesh in 
integrated mode. You can improve the display performance of large models. 

Benefits and Description  (200words) 

The performance and display options for viewing the AutoGEM mesh in integrated 
mode have been improved. You now have control over the display quality (fine, 
medium, and coarse). Additionally, a shell element can be displayed as in 
Pro/ENGINEER with its thickness or with a zero thickness (as in the standalone).

User Interface Location  

View / Simulation Display
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Structural and Thermal Simulation 

Simulation (Mechanism Dynamics, Design Animation) 

Title  

Object and Model Information in HTML 

Summary  

Information summaries for Simulation modeling entities now display in HTML using 
the Pro/ENGINEER browser. 

Benefits and Description  (200words) 

The information summaries in the Pro/ENGINEER browser are easier to read and 
contain more information, such as hyperlinks to the referenced entities, other 
simulation modeling objects, coordinate systems, and geometry. The HTML browser 
makes it easier to interrogate your model and to share it with others.

User Interface Location  

None
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Structural and Thermal Simulation 

Simulation (Mechanism Dynamics, Design Animation) 

Title  

Free Connection Type More Robust

Summary  

The robustness of the Free connection type for interfaces in Structural and Thermal 
Simulation is improved. 

Benefits and Description  (200words) 

Using Free connection, you can model press-fit models without using standalone mode. 

User Interface Location  

Insert / Connection / Interface
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Structural and Thermal Simulation 

Simulation (Mechanism Dynamics, Design Animation) 

Title  

FEM Meshing Robustness and Performance 

Summary  

FEM meshing performance has been improved for assembly, multi-volume part, and 
mixed mesh models. The meshes are more robust.

Benefits and Description  (200words) 

Solid meshing in FEM mode for the following model types has been greatly improved: 
• Multi-volume parts (volume regions, and so forth) 
• Assemblies 

• Mixed mesh models (solids and shells) 
Besides performance improvements, FEM meshing provides more robust meshes. This 
increased quality of the meshes reduces the time to create a mesh to your satisfaction.

User Interface Location  

Mesh / Create
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Structural and Thermal Simulation 

Simulation (Mechanism Dynamics, Design Animation) 

Title  

FEM Meshing Quality

Summary  

The FEM mesher now takes curvature and geometry proximity into account when 
creating the solid mesh.

Benefits and Description  (200words) 

Enhancements to the FEM mesher make it easier and quicker to create high-quality 
meshes for use with third-party solvers. When you create a solid mesh, surface 
curvature and geometric proximity are taken into account. Curvature refinement 
creates more, better-shaped elements, in areas where your model geometry is curved 
such as in rounds and around holes. Proximity refinement creates more elements with 
improved aspect ratios in areas of the model that are thin, such as where a hole is near 
the surface of a model.

User Interface Location  

Mesh / Create
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Structural and Thermal Simulation 

Simulation (Mechanism Dynamics, Design Animation) 

Title  

Shape Optimization Improvements in FEM Mesh

Summary  

For FEM mesh elements, the optimization step in the meshing process has been 
improved to increase element quality.

Benefits and Description  (200words) 

After you create a FEM mesh, you can perform steps to optimize the element shape 
before you complete the mesh. The algorithm for the optimization results in better 
quality for elements in your solid meshes.

User Interface Location  

Mesh / Improve
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Structural and Thermal Simulation 

Simulation (Mechanism Dynamics, Design Animation) 

Title  

Create FEM Mesh Dialog Box

Summary  

The Create FEM Mesh dialog box provides all commands for the element types to 
generate the mesh. This concise dialog box merges all the Menu Manager commands 
for FEM mesh creation.

Benefits and Description  (200words) 

In addition to being easier to use, the Create FEM Mesh dialog box retains the last 
settings that were used to create a mesh (solid, mixed, mid-surface). Consequently, you 
can more easily re-create your mesh at a future date.

User Interface Location  

Mesh / Create
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Structural and Thermal Simulation 

Simulation (Mechanism Dynamics, Design Animation) 

Title  

Support of family tables in Structural and Thermal

Summary  

You can now define family table instances of your simulation models.  Additionally, 
simulation-modeling objects may be manually suppressed and resumed.

Benefits and Description  (200words) 

Simulation modeling objects may now be suppressed by family table instance.  In 
standard mode of Pro/ENGINEER, if you define an instance, upon entry to Structural 
and Thermal you will be able to add simulation-modeling objects (loads, constraints, 
mesh controls, idealizations, etc…) to the family table. 
 
Additionally, you are also now able to manually suppress and resume simulation-
modeling objects either through the edit menu, or directly from within the model tree 
using the right mouse button pop-up menu. 
 
These capabilities make it easier than ever for you to build complex simulation models 
that meet your requirements.

User Interface Location  

Tools -> Family Table
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Structural and Thermal Simulation 

Simulation (Mechanism Dynamics, Design Animation) 

Title  

Enhanced Selection

Summary  

Selection in simulation now supports preselected references and provides an improved 
workflow.

Benefits and Description  (200words) 

It is easier and quicker to build your simulation models. A selection filter has been 
added in the lower-right corner of the Pro/ENGINEER makes it easier to interact with 
complex models. Additionally, you can use preselected references when defining 
modeling objects. For example, if you select a surface, and then open the Pressure 
Load dialog box, the selected surface becomes the reference. That surface is “active” in 
related dialog boxes, so you no longer must pick the references.   Another selection 
enhancement implemented is that selection is “active” as soon as a dialog is invoked; 
you no longer need to select the pick arrow to select the references.

User Interface Location  

N/A 
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Structural and Thermal Simulation 

Simulation (Mechanism Dynamics, Design Animation) 

Title  

Enhanced HTML Result Reporting

Summary  

HTML result reports have been enhanced so you can document and communicate your 
analysis results quickly and easily.

Benefits and Description  (200words) 

You can now include modeling information in your result report, including data such as 
loads, constraints, properties, and any idealizations used. Other additions include a 
user-configurable title block and an improved workflow for creating your report. The 
simplified format of the output report provides for easier editing with standard word 
processing software. 

With the HTML report, you can document your analysis results more completely and 
in less time.

User Interface Location  

In results File / Export / HTML Report
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Structural and Thermal Simulation 

Simulation (Mechanism Dynamics, Design Animation) 

Title  

Display of the Nodal Solution Coordinate System in FEM Mode

Summary  

You can now display the nodal solution (displacement) coordinate system in FEM 
mode.

Benefits and Description  (200words) 

When creating models in FEM mode, many modeling entities can impact the nodal 
solution (displacement) coordinate system when the mesh is output to a solver. With 
this new review tool, you can display the nodal coordinate system without leaving 
Structural and Thermal Simulation. The display of the nodal solution coordinate 
system in FEM mode makes it easier to better understand your FEM model.  To use 
the new tool select to review nodes once you have output your model to the screen.

User Interface Location  

Mesh / Review
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Structural and Thermal Simulation 

Simulation (Mechanism Dynamics, Design Animation) 

Title  

Robustness and performance improvements in simulation geometry 
creation

Summary  

Simulation geometry creation robustness and performance has been dramatically 
enhanced.

Benefits and Description  (200words) 

When you select to interactively AutoGEM a model or start an analysis in integrated 
mode, the geometry of the Pro/ENGINEER model is processed to be suitable for 
Mechanica.   This project improves the performance of this step 10 to 15 times over 
that of previous releases.    This can dramatically reduce the amount of time it takes to 
mesh and solve model in integrated mode. 

User Interface Location  

None
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Structural and Thermal Simulation 

Simulation (Mechanism Dynamics, Design Animation) 

Title  

Mirror Symmetry Constraints

Summary  

Mirror symmetry constraints are implemented in Structural and Thermal Simulation.

Benefits and Description  (200words) 

You can define mirror symmetry constraints in structural analysis models by selecting 
the geometry that lies on the mirror symmetry plane (point, edges, and surfaces). This 
method is fast and easy. These new constraints are displayed on the model and in the 
Model Tree. 

User Interface Location  

Insert / Symmetry Constraint

 

 



What’s New for Pro/ENGINEER Wildfire 2.0 
Formerly Interactive Release Notes 

 

Structural and Thermal Simulation 

Simulation (Mechanism Dynamics, Design Animation) 

Title  

Mesh Control Visibility

Summary  

Mesh controls are now visible whenever you are in simulation mode. 

Benefits and Description  (200words) 

The display of mesh controls can be toggled on or off in the Simulation Display dialog 
box.

User Interface Location  

View / Simulation Display
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Structural and Thermal Simulation 

Simulation (Mechanism Dynamics, Design Animation) 

Title  

Display of Loads and Constraints in Results

Summary  

In results, you can display load and constraint icons. These icons are superimposed on 
the results window as they are on the preprocessor.

Benefits and Description  (200words) 

The display of the load and constraint icons makes it easier to document and to 
communicate how you set up the model. You can create results windows for fringe, 
vector, and model display with the load and constraint icons on the model. You can 
toggle the display of the icons on or off in the Format Result Window dialog box. 

User Interface Location  

Select Format / Result Window
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Structural and Thermal Simulation 

Simulation (Mechanism Dynamics, Design Animation) 

Title  

Mechanism Design Loads Transfer

Summary  

You can automatically transfer loads from Mechanism Design and apply them to your 
structural analysis model. 

Benefits and Description  (200words) 

With load transfer, you are ensured that the load values and referenced coordinate 
transformations are accurate. This accuracy of information simplifies the task of 
performing structural analyses on models simulated in Mechanism Design. 

After running a motion dynamic analysis, you must pick a reference Mechanism Body 
and save the results. Next, you pick a component (part, assembly, or subassembly) to 
which the results will be saved. Reaction forces and inertial acceleration data are then 
written to the specified component part or assembly file. This data is then available 
when you open this component (or an assembly containing it) in Structural and 
Thermal Simulation.  
To use saved loads, you must import the stored Mechanism loads once in Mechanica. 
After import, the load information saved in the component is used to automatically 
create an equivalent and unassociated total load. This load is applied at a point and 
placed into a new Mechanica load set. You can then select the geometry on which the 
loads will be acting.  

User Interface Location  

Insert / Mechanism Load
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Structural and Thermal Simulation 

Simulation (Mechanism Dynamics, Design Animation) 

Title  

Workflow for Model Types

Summary  

The workflow for entering Structural and Thermal Simulation and specifying the 
model type has been streamlined.

Benefits and Description  (200words) 

When you enter Structural and Thermal Simulation for the first time with a new 
model, the Model Type dialog box opens so you can specify the type of model to work 
on. On subsequent entries, these settings remain so you begin in the same mode as 
your previous model type. To edit the model type, click Edit > Mechanica Model 
Type. 
This improved workflow for model types reduces the amount of time it takes to switch 
between standard and Structural and Thermal Simulation. Thus, it is easier to make 
iterations to your design.

User Interface Location  

Edit / Mechanica Model Type
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Structural and Thermal Simulation 

Simulation (Mechanism Dynamics, Design Animation) 

Title  

Redesigned measures

Summary  

Measures functionality in Structural and Thermal Simulation has been greatly 
enhanced in Wildfire 2.0 to improve usability and functionality.

Benefits and Description

Measures have been redesigned in the Wildfire 2.0 release in order to enhance both the 
usability as well as the functionality of measures.  

When you select to create a new measure, you will see that the user interface for 
defining them is more streamlined than in previous releases.  You will also notice that 
as measures are created, they appear both on the model, as well as in the model tree.  
Some of the other enhancements to measures include the following: 

• Measures from a lower level model can be made visible in higher-
level assemblies  

• The ability to select geometry for evaluation location (surfaces, 
curves, components, etc…) 

• The ability to define computed measures in Structural and Thermal 
• Multi-edit capability to quickly place multiple instances of point 

measures at different locations in a model. 

This new functionality will make is quicker and easier for you to build and interpret 
the results of your analysis models. 

User Interface Location  

Insert -> Simulation Measure 
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Structural and Thermal Simulation 

Simulation (Mechanism Dynamics, Design Animation) 

Title  

Results Templates

Summary  

Results templates can be defined and used to dramatically reduce the amount of time it 
takes to generate results in Structural and Thermal Simulation. 

Benefits and Description  (200words) 

With results templates, you can quickly format and display results from different 
analyses, automating this repetitive task. Saving a set of results windows that you 
prefer to a template is easy (File > Save as Template). You can choose whether to 
save the legend values, model orientation, annotations (if present), and the deformed 
scale to the template. By default, the template is saved to the working directory. You 
can, however, specify a template directory using the config.pro file. 

When you define new results windows from a template, select the template that you 
want to use and the study directory to which to apply it. If the study directory contains 
multiple load sets or modes, you can either repeat the template for each load set or 
mode, or you can combine them.

User Interface Location  

Select Insert / Results Window from Template
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Structural and Thermal Simulation 

Simulation (Mechanism Dynamics, Design Animation) 

Title  

New Search Tool in Simulation

Summary  

The Pro/ENGINEER Search tool for advanced selection now works in simulation mode.

Benefits and Description  (200words) 

With the new Search tool, you can search by the following attributes:   
• Name 
• Type (loads, beams, and so forth) 

• Property (materials, shell property, beam sections, and so forth) 
In addition to advanced selection capabilities, the Search tool can also be used to build 
queries and define layers by rule (for example, a layer that contains all shells with the 
material property Steel assigned to them).

User Interface Location  

Edit / Find
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Structural and Thermal Simulation 

Simulation (Mechanism Dynamics, Design Animation) 

Title  

Coordinate System Control for Shell Elements 

Summary  

The Shell Element coordinate system mesh control option provides control of the 
coordinate system direction area for shell element.

Benefits and Description  (200words) 

You can control the shell element coordinate system. With this mesh control, you can 
align the shell element coordinate system determined by the numbering of the nodes to 
a selected coordinate system. This alignment provides more precise control of the 
solver input deck that is generated in FEM mode.

User Interface Location  

Mesh / Control
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Structural and Thermal Simulation 

Simulation (Mechanism Dynamics, Design Animation) 

Title  

Master Control for Display of Simulation Entities

Summary  

You can now toggle the display of all simulation modeling entities with a single control. 

Benefits and Description  (200words) 

The display of large simulation models can become cluttered. With the master control 
(the Show Simulation Entities check box) on the Simulation Display dialog box, 
you can temporarily override the other settings and toggle the display of the simulation 
modeling objects. 

User Interface Location  

View / Simulation Display
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Structural and Thermal Simulation 

Simulation (Mechanism Dynamics, Design Animation) 

Title  

Saving sketched beam sections to a library

Summary  

Sketched beam sections may now be saved to a library.

Benefits and Description  (200words) 

It is now possible for you to save sketched beam sections to the beam section library.  
Additionally, a config.pro option has been added where the location of the beam section 
libraries directory may be specified (sim_beamsection_path).

User Interface Location  

Properties -> Beam Sections
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Structural and Thermal Simulation 

Simulation (Mechanism Dynamics, Design Animation) 

Title  

Weld definition dialog

Summary  

A new dialog has been implemented for perimeter and end weld definition. 

Benefits and Description  (200words) 

End and perimeter weld definition has been simplified through the implementation of 
a new definition dialog.

User Interface Location  

Insert -> Connection -> Weld
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Structural and Thermal Simulation 

Simulation (Mechanism Dynamics, Design Animation) 

Title  

Two point rigid connections

Summary  

Rigid connections may now be defined between 2 points.

Benefits and Description  (200words) 

Rigid connections in Structural and Thermal Simulation may now be defined between 
2 points.  In past releases, the minimum number of points required to define a rigid 
connection was three non-collinear points.

User Interface Location  

Insert -> Connection -> Rigid Connection
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Structural and Thermal Simulation 

Simulation (Mechanism Dynamics, Design Animation) 

Title  

Enhanced Total Load Review

Summary  

Total load review has improved functionality and usability.

Benefits and Description  (200words) 

Total load review is now in the Load Resultant dialog box rather than in the Menu 
Manager. In addition to improved usability, you can: 

• Select non-WCS coordinate systems 
• Select the point about which the load resultant is computed 
• Access total load review in FEM mode 

User Interface Location  

Info / Review Total Load
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Structural and Thermal Simulation 

Simulation (Mechanism Dynamics, Design Animation) 

Title  

Migration from the Menu Manager to Top-Level Menus

Summary  

Menus in Structural and Thermal Simulation have been migrated from the Menu 
Manager to the top-level menus. 

Benefits and Description  (200words) 

Commands in simulation mode have migrated from the Menu Manager to the top-level 
menus in Structural and Thermal Simulation. This simplifies the user interface by 
making it much easier and faster to locate commands. This change makes it possible to 
expand the graphics window. 

User Interface Location  

N/A
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Structural and Thermal Simulation 

Simulation (Mechanism Dynamics, Design Animation) 

Title  

Tolerance report

Summary  

The tolerance report simplifies the process of understanding why assembly models may 
fail to mesh. 

Benefits and Description  (200words) 

Large variations in model accuracy can cause problems during meshing.  The tolerance 
report provides a quick way in which you can see the model accuracy of all of the 
components in an assembly, spotting which model may be causing problems by having 
too large an accuracy setting.

User Interface Location  

Info -> Tolerance Report
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Application Programming Toolkit 

Data Exchange (ATB, DataDoctor, Interfaces) 

Title  

Expanded and Improved Programmatic Access

Summary  

Expanded programmatic access is provided to features, sections, and sketches in 
Pro/ENGINEER. In addition, improvements to section and sketcher related 
functionality in Pro/TOOLKIT are significant.

Benefits and Description

The feature element trees of the following Pro/ENGINEER features have been 
published: 

• Round 
• Draft 
• Shell  

• Move 
• Mirror 
• Trim 
• Thicken 

• Merge 
• Solidify (formerly Patch) 
• Sheetmetal flat wall 
• Sheetmetal flange wall 

Included in Pro/TOOLKIT are utility type functions for increased coverage to the 
section interface. For example, you can calculate the number and type of loops for a 
section. This output can help validate the section before trying to use it to create a 
Pro/ENGINEER feature.  Expanded coverage and utilities for programmatic feature 
creation are part of the commitment of PTC to data interoperability and openness. 

User Interface Location  

N/A 
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Application Programming Toolkit 

Data Exchange (ATB, DataDoctor, Interfaces) 

Title  

Pro/Web.Link (JavaScript API) on UNIX 

Summary  

Pro/Web.Link (Pro/ENGINEER browser version), the JavaScript interface to 
Pro/ENGINEER, is now supported on UNIX platforms. The API is the same as the 
Microsoft Internet Explorer-based Pro/Web.Link introduced in Pro/ENGINEER 
Wildfire.

Benefits and Description  (200words) 

The new architecture of Pro/Web.Link runs in the Pro/ENGINEER browser (Microsoft 
Internet Explorer on Windows and Mozilla using XPCOM on UNIX).  
Pro/Web.Link links the World Wide Web to Pro/ENGINEER, so you can use the 
browser and the Internet as tools to automate and streamline parts of your engineering 
process. You can load Pro/Web.Link pages directly into the Pro/ENGINEER browser. 
The new version of Pro/Web.Link offers a number of benefits: 

• Easy setup (no separate plug-ins required, installed by default with 
Pro/ENGINEER)  

• Extensive Pro/ENGINEER functionality covered 
• Ability to call into Pro/TOOLKIT or J-Link task libraries 
• Single interface (Pro/ENGINEER browser, so no additional 

windows are required) to interact with Pro/ENGINEER.

User Interface Location  

N/A
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Application Programming Toolkit 

Data Exchange (ATB, DataDoctor, Interfaces) 

Title  

Pro/Web.Link (JavaScript API) on UNIX 

Summary  

Pro/Web.Link (Pro/ENGINEER browser version), the JavaScript interface to 
Pro/ENGINEER, is now supported on UNIX platforms. The API is the same as the 
Microsoft Internet Explorer-based Pro/Web.Link introduced in Pro/ENGINEER 
Wildfire.

Benefits and Description  (200words) 

The new architecture of Pro/Web.Link runs in the Pro/ENGINEER browser (Microsoft 
Internet Explorer on Windows and Mozilla using XPCOM on UNIX).  
Pro/Web.Link links the World Wide Web to Pro/ENGINEER, so you can use the 
browser and the Internet as tools to automate and streamline parts of your engineering 
process. You can load Pro/Web.Link pages directly into the Pro/ENGINEER browser. 
The new version of Pro/Web.Link offers a number of benefits: 

• Easy setup (no separate plug-ins required, installed by default with 
Pro/ENGINEER)  

• Extensive Pro/ENGINEER functionality covered 
• Ability to call into Pro/TOOLKIT or J-Link task libraries 
• Single interface (Pro/ENGINEER browser, so no additional 

windows are required) to interact with Pro/ENGINEER.

User Interface Location  

N/A
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Application Programming Toolkit 

Data Exchange (ATB, DataDoctor, Interfaces) 

Title: Feature Element Trees in XML

Summary  

The XML feature engine in Pro/TOOLKIT helps construct Pro/ENGINEER features 
based on XML definitions for the feature element tree. 

Benefits and Description

Pro/TOOLKIT now includes functions to write the contents of a feature element tree to 
XML format as well as to read an XML file to construct a feature element tree. Schema 
files as templates for some feature types help validate the construction of the XML files 
used in creating the feature element tree.   Pro/TOOLKIT now provides direct 
conversion between feature element trees and standard XML format files. This 
mechanism supports the following types of element value:  

• Integer / enumerated type  

• String  
• Wide string  
• Boolean  
• Transform  

• Reference  
• Reference array (“multivalued” element)  
• Model (component model pointer)  
• Curve collection  

• Surface collection  

Easier representation of the element trees in the form of XML documents simplifies the 
feature creation procedure. By using XML as a neutral file format for exchanging 
feature element trees, you can effectively separate data from the Pro/TOOLKIT 
application for the creation or modification of various features. You modify the XML 
file and not the application. 

User Interface Location: N/A
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Application Programming Toolkit 

Data Exchange (ATB, DataDoctor, Interfaces) 

Title  

User Interface Improvements in Pro/TOOLKIT

Summary  

Pro/TOOLKIT contains a number of user interface enhancements for seamless 
integration of interfaces developed with Pro/TOOLKIT. 

Benefits and Description  (200words) 

Significant improvements in usability continue to support introduction of object-action 
and action-object tools. Programmatic access has been provided to many of these 
individual areas of improvements, such as the ability to: 

• Access the contents of selection buffers and tools. 
• Add context-sensitive buttons to the shortcut menus (right-click) in 

the graphics window and in the Model Tree. 

• Assign pop-up menus to custom dialog boxes. 

• Display the Parameter dialog box and allow a flexible context for 
selection. 

With these enhancements, you can develop custom user interfaces with a similar look 
and feel to Pro/ENGINEER yet integrated with other applications for a streamlined 
user experience..

User Interface Location  

N/A
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Complete Machining Option 

Manufacturing (NC, Expert Machinist, GPOST, FIL) 

Title  

NC Sequence for 2-Axis Trajectory Milling 

Summary   .

New 2-axis trajectory milling supports milling or drilling tools, and automatic material 
removal in expert machining. 

Benefits and Description   

The NC sequence for 2-axis trajectory milling answers requests for specific machining 
techniques. It allows the selection of a drilling tool to drive along a curve to create, for 
example, a “break edge” NC Sequence. This is a very common practice in high-
production machining where the same tool that was used to drill a hole is used to cut a 
small chamfer to reduce the tool change time. 

This new NC sequence, based on the freehand tool path, supports automatic material 
removal. It also supports Arc Fitting, allowing a spline to be output as circular 
interpolation (using the parameter approximate_splines set to yes).  

User Interface Location  

MACHINING / NC Sequence / NC Sequence / Trajectory / 2 Axis in Pro/NC
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Complete Machining Option 

Manufacturing (NC, Expert Machinist, GPOST, FIL) 

Title  

Tool Adaptors with Fixed Orientation 

Summary   

Support for tool adaptors (for example, right-angle head) in Pro/NC provides a 
mechanism to assign a fixed, nonvertical position for a cutting tool.

Benefits and Description  

The adaptor for milling NC sequences can support right-angle or any fixed orientation 
head. Both tool and adaptor are simulated in Shaded mode, so you can check visually 
for collision. A SET/HOLDER command with CSYS offset information is generated in 
the CL file, allowing the post-processor to compensate for the adaptor orientation. 

Adaptors are defined using a Pro/ENGINEER solid model with two coordinate systems: 

• TOOL_ATTACH_POINT—Defines the tool axis orientation and tool 
location. 

• SPINDLE_CONTROL_POINT—Defines the spindle axis and location. 

User Interface Location  

Machining / NC Sequences / select any milling toolpath / Seq Setup / Adaptor
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Complete Machining Option 

Manufacturing (NC, Expert Machinist, GPOST, FIL) 

Title  

Finishing Tool Path for Surface Machining

Summary  

The new finishing tool path provides optimum surfacing for steep, shallow, and flat 
surface machining, including crosscut surfaces. Surface slope rather than boundaries 
determines the machining strategies. 

Benefits and Description  (200words) 

With the new Finishing tool path, you can automate a procedure for creating an 
optimized, surface machining tool path based on the threshold surface angles. Steep 
surfaces are machined using high-speed machining, Z-profile cuts using an “S 
connection.” Shallow and flat surfaces are machined either with straight (conventional) 
cuts or the new, high-speed spiral cuts. You have complete control on which area needs 
to be machined and in which order. 

This new tool path requires minimum input to cut cost by reducing manufacturing 
lead-time. The optimized tool path produces a quality surface finish.

User Interface Location  

MACHINING / NC Sequence / Finishing
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Complete Machining Option 

Manufacturing (NC, Expert Machinist, GPOST, FIL) 

Title  

Step-Depth Control for Engraving 

Summary  

The engraving tool path has been improved to offer step-depth control and multiple 
groove selection. 

Benefits and Description  (200words) 

As an NC Programmer, you can now machine cosmetic grooves with multiple passes 
using the STEP_DEPTH parameter in the engraving tool path. In addition, using arc 
output can minimize the toolpath length and improve quality. 

By using multiple groove selection, you can avoid the definition of additional NC 
sequences. 

User Interface Location  

MACHINING / NC Sequence / Engraving / Seq Setup / Parameters
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Design Collaboration Extension (DCX) 

Fundamentals (Fundamentals, Design Conferencing) 

Title  

E-mail of Invitations from the PTC Conference Center

Summary  

From the PTC Conference Center through electronic mail, you can directly invite 
participants outside or inside the local domain. 

Benefits and Description  (200words) 

The invitation process has been streamlined, speeding the process and making it easy 
to use. Directly from within the Conference Center, you can follow the standard 
invitation process and include any e-mail addresses. The conference invitation is 
attached to the e-mail. All the recipient need do is accept the invitation and 
dynamically join the conference.

User Interface Location  

From within a conference in the PTC Conference Center, use the Extend invitation to 
join conference icon and the Invite a participant to a conference by email icon.  
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Complete Machining Option 

Manufacturing (NC, Expert Machinist, GPOST, FIL) 

Title  

Support for Multi-tip Tools 

Summary  

Pro/NC supports multiple control points for the existing tools and a new type of “multi-
tip “ or “stage” tool with multiple control points and diameters.  

Benefits and Description  (200words) 

For series or production machining, special tools are often required. With one tool, 
different diameters or faces can be manufactured. To simplify the definition and the 
programming of these tool types in Pro/NC, the definition and the control of multiple 
control points has been added to tool definition. A new type of “multi-tip “ or “stage” 
tool, with multiple control points and diameters, is available for trajectory and 
holemaking sequences. 

As an NC programmer, you can now select during a tool path which tool tip is driven. 
Combined with a custom cycle, multi-tip tools provide programmers for series 
machining with a powerful tool to cover special production needs for holemaking.  

User Interface Location  

Tool Manager
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Complete Machining Option 

Manufacturing (NC, Expert Machinist, GPOST, FIL) 

Title  

Roughing, Reroughing, and Finishing of Imported STL Data 

Summary  

As Pro/NC user, you can machine directly imported STL data. Three tool paths are 
available for roughing, reroughing, and finishing. 

Benefits and Description  (200words) 

Stereolithography (STL) refers to the representation of 3D forms as a boundary 
representation of solid models that are constructed entirely of triangular facets. It is a 
format used mainly during the concept phase or prototyping.  

You can directly machine an STL model or a combination of STL, surfaces, and solids, 
using three toolpath types: Roughing, Re-roughing, and Finishing. 

Because the mathematical representation of the faceted model is quite simple, toolpath 
computation is optimized. Direct machining of STL data provides a cheap solution (no 
need for an STL machine) for rapid prototyping during the concept phase.

User Interface Location  

MACHINING / NC Sequence / Roughing, Re-roughing, or Finishing 
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Complete Machining Option 

Manufacturing (NC, Expert Machinist, GPOST, FIL) 

Title  

Job Manager 

Summary  

Job Manager for batch toolpath computation for NC sequences and operations can be 
started from the Model Tree. 

Benefits and Description  (200words) 

Directly from the Model Tree, you can start the toolpath computation using Job 
Manager on a complete operation, on a single NC sequence, or on a multiple selection 
of NC sequences. Right-click an item in the Model Tree and select Job Manager from 
the shortcut menu. 

The shortcut menu improves productivity by giving an easy way to start the Job 
Manager to compute the selection from the Model Tree. The Job Manager 
automatically calculates any selection, such as one or more operations, or continuous or 
noncontiguous NC sequences. It creates all necessary settings on the fly. 

User Interface Location  

In the Model Tree, right-click an NC sequence or operation. Select Job Manager from 
the shortcut menu.
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Complete Machining Option 

Manufacturing (NC, Expert Machinist, GPOST, FIL) 

Title  

Merging Drilling Steps 

Summary  

Using the Process Manager, you can merge consecutive drilling steps using the same 
tool into a single, optimized NC step. 

Benefits and Description  (200words) 

In addition to methods to create optimized tool paths for drilling NC sequences, the 
Process Manager offers the ability to merge independent but consecutive drilling steps 
using the same drilling tool. You can prepare the NC process while thinking feature by 
feature. Later in the process, you can optimize the tool path between holes; which gives 
better flexibility in the process definition. 

User Interface Location  

In the Process Table, select consecutive drilling steps using the same tool. Right-click 
and select Merge from the shortcut menu, or use Edit / Merge in the Process Table.
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Complete Machining Option 

Manufacturing (NC, Expert Machinist, GPOST, FIL) 

Title  

Templates in Process Manager 

Summary  

NC templates can be used to automate the NC process creation. 

Benefits and Description  (200words) 

From the Process Manager’s Process Table, you can store any selection of one or more 
steps as a template. A template is an XML file that includes the definition of the 
selected steps, which can be reused to create NC steps in the Process Table. You can 
easily store and reuse best practices without creating manufacturing UDFs. 

User Interface Location  

Select the steps to include in the template, and then click the icon in the Process 
Manager’s Process Table.
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Complete Machining Option 

Manufacturing (NC, Expert Machinist, GPOST, FIL) 

Title  

Process Manager for Pro/NC and the Process Table 

Summary  

A Process Manager extends Pro/NC capabilities in terms of viewing and editing an NC 
process. 

Benefits and Description  (200words) 

The new Process Manager in Pro/NC allows viewing of any manufacturing files created 
with Pro/NC in a table environment: the Process Table. Using this table, you can define 
custom views such as the coordinate system, retract planes and references, any 
parameter, and the cutting time. 

Directly from the Process Table, you can edit the steps guided by the dashboard. By 
right-clicking a selection, you can play a single step or multiple steps, and play selected 
contiguous or noncontiguous steps. 

User Interface Location  

Process Manager button in the Menu Manager in a Pro/NC session or the dedicated 
icon in a Pro/NC session
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Complete Machining Option 

Manufacturing (NC, Expert Machinist, GPOST, FIL) 

Title  

Process Export for Pro/NC from the Process Table 

Summary  

By exporting a manufacturing process from the Process Table (steps) in CSV format, 
you can use it in a Microsoft Excel spreadsheet. 

Benefits and Description  (200words) 

Any information based on a view layout (see Views in Process Manager) can be 
exported into a CSV file for use directly by Microsoft Excel. With the CSV file, you can 
generate any kind of report using the standard Microsoft Excel functions. 

User Interface Location  

File / Export Table (CSV) in the Mfg Process Table dialog box
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Complete Machining Option 

Manufacturing (NC, Expert Machinist, GPOST, FIL) 

Title  

Start Model for Pro/NC 

Summary  

Pro/NC sessions can be started by using a “start model” similar to the parts and 
assemblies model “start part.”

Benefits and Description  (200words) 

As an NC Programmer, you can now start a new NC session from an existing 
environment. Any existing NC file can be reused as a start model. A typical start model 
can include components for the fixture, operations, machine tools, probes, and so forth. 

User Interface Location  

File / New / select Use Default Template / set the two config.pro options:  

mfg_start_part set to yes 
start_model_dir set to the directory where the start model is stored 
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Complete Machining Option 

Manufacturing (NC, Expert Machinist, GPOST, FIL) 

Title  

Referencing a Previous NC Reroughing Tool Path 

Summary  

The reroughing NC Sequence allows the selection of a previous reroughing tool path as 
a reference. 

Benefits and Description  (200words) 

As an NC Programmer, you can now select a previous reroughing NC sequence as a 
reference for a new reroughing operation. Material left by the previous roughing and 
reroughing parent sequences are machined by the new reroughing tool path. 

User Interface Location  

MACHINING / NC Sequence / Re-roughing / Select NC sequence from sequence list 
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Complete Machining Option 

Manufacturing (NC, Expert Machinist, GPOST, FIL) 

Title  

Shaded Tool for NC Toolpath Simulation 

Summary  

Toolpath simulation in Pro/NC displays the tool shaded, allowing dynamic rotation and 
zooming during simulation. It automatically performs line removal on the tool path 
motions.

Benefits and Description  (200words) 

To improve simulation and facilitate toolpath verification, the NC Sequence Play 
Path, by default, shades the tool during the simulation. This shading applies to 
standard, sketched, and solid tools.  

Line removal is automatically processed for the toolpath motions, allowing better 
visibility of the tool path. Dynamic model view manipulations (zoom, pan, rotate) are 
also allowed during toolpath simulation, giving complete control of the simulation. 

To simplify access to toolpath simulation, Play Path (CL Player) is directly available in 
the Model Tree using a shortcut (right-click) menu. You can select an individual NC 
sequence, a set of sequences, and an operation for toolpath simulation from the Model 
Tree. 

User Interface Location  

MACHINING / NC Sequence / Play Path / Screen Play /  …then select View / Shaded 
Tool 
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Complete Machining Option 

Manufacturing (NC, Expert Machinist, GPOST, FIL) 

Title  

Views in Process Manager 

Summary  

You can create custom views in Process Manager. 

Benefits and Description  (200words) 

By formatting the Process Table, you can display any information related to the 
machining process. You can also choose what information to include. These custom 
views allow you to select which step information should be displayed, in which order it 
should be presented, and eventually which way to filter it. When exporting the table 
into a CSV file, this exact content is exported. 

User Interface Location  

The icon for View Builder in the Process Table
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Complete Machining Option 

Manufacturing (NC, Expert Machinist, GPOST, FIL) 

Title  

Toolpath Computation 

Summary  

Toolpath computation for NC sequences and operations can be done from the Model 
Tree. The simulation is done with a shaded tool for a single-step display. 

Benefits and Description  (200words) 

Directly from the Model Tree, you can start the toolpath computation on a complete 
operation, on a single NC sequence, or on a multiple selection of NC sequences. Right-
click an item in the Model Tree and select Play Path from the shortcut menu. 

The shortcut menu improves productivity by providing an easy way to start the CL 
player to play the selection from the Model Tree. The Play Path command provides 
automatic simulation of any selection, such as one or more operations, or continuous or 
noncontiguous NC sequences. It creates all necessary settings on the fly. 

User Interface Location  

In the Model Tree, right-click an NC sequence or operation. Select Play Path from the 
shortcut menu.
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Mechanism Design Extension (MDX) 

Simulation (Mechanism Dynamics, Design Animation) 

Title  

Mechanism’s 6 Degrees of Freedom Connection 

Summary   

A 6 Degree of Freedom (DOF) connection provides you with the flexibility to specify 
connection constraints to real-world problems.  

Benefits and Description  

With a 6 DOF connection, you can model connections unaccounted for with currently 
available joint and connection types. This ability makes it easier and quicker to 
complete a mechanism model. You can easily: 
• Model and drive spatial, 3D motion of a free body, such as a falling ball. 
• Model and apply servomotor-driven profiles to the rotational DOF of a bearing-joint 

ball. Previously, joint axes were not available for these joint types. 

• Model an unlimited number of general joints that require various combinations of 
the three translations and three rotational DOF of a body.  

User Interface Location  

Insert / Component / Assemble / Connect / 6DOF
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Mechanism Design Extension (MDX) 

Simulation (Mechanism Dynamics, Design Animation) 

Title  

Cam Measures for Mechanism 

Summary  

Curvature, Pressure Angle, and Slip Velocity have been added to the measures 
commands to expand the results available for examining cam connection, kinematic 
behavior. 

Benefits and Description  (200words) 

You can generate expanded results for Cam connections for the following measure 
types to match the functionality of Mechanica Motion:  
• Curvature—Measures the curvature (1/r) at the point of contact for the specified 

cam surface. 
• Pressure Angle—Measures the angle (degrees) between the normal on the 

specified cam and the velocity of the contact point. 
• Slip velocity—Measures the tangential velocity of the contact points on each cam 

surface relative to one another.

User Interface Location  

Mechanism / Measures / New / Type / Cam
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Mechanism Design Extension (MDX) 

Simulation (Mechanism Dynamics, Design Animation) 

Title  

Evaluation at Time and at Intervals 

Summary  

Design Studies in Mechanism design (MDO) can measure the performance of a 
mechanism at a particular instance in time and at intervals.

Benefits and Description  (200words) 

Evaluation of a measure at a specified time allows you to run evaluation analysis at a 
particular time during the motion run. In this fashion, design studies can query 
performance measurement at desired and discrete intervals throughout the time 
domain of an analysis. Dynamic analyses can be run with 0 duration to query the value 
of a measure at time = 0. 

User Interface Location  

In the Measure Definition dialog box, select either At Time or Each Time Step from the 
Evaluation Method menu.
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Mechanism Design Extension (MDX) 

Simulation (Mechanism Dynamics, Design Animation) 

Title  

Point-to-Point Separation Measure and Forces 

Summary  

Mechanism Dynamics supports the ability to define point-to-point separation measures 
and forces, which match the functionality of Mechanica Motion. 

Benefits and Description  (200words) 

You can generate expanded results for Mechanism Dynamics for accurate 
measurement of the separation distance, speed, and dependent forces, such as 
nonlinear springs and dampers. 

Point-to-Point Separation Measure allows you to capture separation distance, velocity, 
and acceleration between two points. You can specify force expressions dependent upon 
point-to-point separation, velocity, and acceleration. Currently, the creation of a point-
to-point distance measure is only provided through BMX. 

Forces can now be defined at a point relative to a coordinate system, on a joint axis, or 
as linear springs. Point-to-point forces enable generalized separation distance for 
dependent forces, such as nonlinear springs, nonlinear dampers, and magnetic forces 
that accept both table input and user-defined expressions. 

User Interface Location  

Application / Mechanism
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Mechanism Design Extension (MDX) 

Model Analysis (BMX, ModelCHECK, Pro/PROGRAM) 

Title  

Subassembly Mechanism Editing 

Summary  

All Mechanism entities, such as motors, springs, and joints, are accessible from the top-
level assembly for creating, editing, or deleting.

Benefits and Description  (200words) 

You can work directly with any mechanism entity from within the top-level assembly. 
During direct modeling workflow, use preselection highlighting, Model Tree selection, 
or context-sensitive shortcut menus (right-click) to activate a subassembly to create, 
edit, or delete mechanism entities. This improved workflow within mechanism models 
decreases the time to manipulate a mechanism model, improves the ability to visualize 
the work being completed, and provides behavior consistent with Pro/ENGINEER 
assemblies.

User Interface Location  

Right-click menu / Activate
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Distributed Applications 

Data Exchange (ATB, DataDoctor, Interfaces) 

Title  

ATB Operations and New Data Interfaces in Distributed Pro/BATCH. 

Summary  

Distributed Pro/BATCH now supports the new data interfaces introduced in Pro/E 
Wildfire 2.0. Also, you can now perform Associative Topology Bus (ATB) update and 
verify operations in batch mode on remote network machines.

Benefits and Description  (200words) 

In Pro/E Wildfire 2.0, you can use Distributed Pro/BATCH to perform import and 
export of new data interfaces introduced in this release. Batch processing templates 
(TTD) are included for the following new formats: 

• CATIA V5 CATPart (Import) 
• I-DEAS (Import) 
• Unigraphics (Import and Export) 

• Parasolid (Export) 
Distributed Pro/BATCH allow allows you to offload the time-consuming and resource 
intensive ATB operations to be processed in batch mode on one or more remote 
machines on your network. The following types of ATB operations can be performed 
using dBATCH: 

• Verify 
• Update

User Interface Location  

N/A
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Distributed Applications 

Data Exchange (ATB, DataDoctor, Interfaces) 

Title  

Distributed Computing Toolkit to truly leverage your network resources.

Summary  

Distributed Computing technology is Wildfire 2.0 is greatly enhanced with the 
introduction of a C (C++ compatible) and Java Application Programmers Interface 
(API) for developing custom distributed applications.

Benefits and Description  (200words) 

In the Pro/E Wildfire release, PTC introduced the ‘Distributed Services Manager’ and 
‘Distributed Pro/BATCH’, a client/server application that allowed you to perform 
common Pro/E operations like plotting, import/export, etc. on remote network 
machines in a distributed computing environment. With Pro/E Wildfire 2.0, you can 
develop your own custom clients/server applications that will utilize the distributed 
processing capabilities of the DSM in performing the desired tasks on remote 
networked machines. 
When you install the DSM, you can also choose to install the C and Java toolkits that 
will allow you to build custom plug-in components (distributed clients and services).  
 

User Interface Location  

N/A

 

 


